
PROGRESS USER GUIDE

Progress Web



[[[Undefined variable Local.ModuleName]]]

Page 2 of 212 InEight Inc.  |  Release 26.3

Release 26.3
Last Updated: 15 May 2026



Information in this document is subject to change without notice. Companies, names and data used in
examples are fictitious.

Copyright ©2026 by InEight. All rights reserved. No part of this document may be reproduced or
transmitted in any form or by any means, electronic or mechanical, for any purpose, without the
express permission of InEight.

Microsoft Windows, Internet Explorer and Microsoft Excel are registered trademarks of Microsoft
Corporation.

Although InEight Progress has undergone extensive testing, InEight makes no warranty or
representation, either express or implied, with respect to this software or documentation, its quality,
performance, merchantability, or fitness for purpose. As a result, this software and documentation are
licensed “as is”, and you, the licensee are assuming the entire risk as to its quality and performance. In
no event will InEight be liable for direct, indirect, special, incidental or consequential damages arising
out of the use or inability to use the software or documentation.

InEight Inc.  |  Release 26.3 Page 3 of 212

Release 26.3
Last Updated: 15 May 2026



Page 4 of 212 InEight Inc.  |  Release 26.3

This page intentionally left blank.



CONTENTS
CHAPTER 1 — DAILY PLANNING 15
1.1 InEight Progress Overview 17
1.1.1 InEight Progress Daily Planning Phases 17
1.1.2 Daily Plan Work Flow 18
1.1.3 InEight Control Integration 19
1.1.4 Daily Planning 20
1.1.5 Daily Execution 21
1.1.6 Daily Approval 22
1.1.7 Work Flow Beyond InEight Progress 22
1.1.7.1 Hours 22
1.1.7.2 Quantities and Costs 22

1.2 Daily Plan Creation 24
1.3 Daily Plan fromWork Package (Daily Plan Wizard) 25
1.3.1 What is a Daily Plan? 26
1.3.2 Daily Plan Wizard 26
Create a Daily Plan Using the Daily Plan Wizard 29

1.4 Daily Plan from Copy 36
1.4.1 Copy a Daily Plan 36
Create a Daily Plan by Copying an Existing Daily Plan 39

1.5 Daily Plan from Scratch 42
1.5.1 Daily Plan from Scratch 42
1.5.1.1 Approver and Executor Roles 42
1.5.1.2 Vendor association 43
Create a Daily Plan from Scratch 45

1.6 Completing a Daily Plan 49
1.6.1 Daily Plans Page 50
Open a Daily Plan 50
Daily Plan review 51

1.6.2 Overview Tab 51
1.6.3 Details Tab 52
1.6.4 Time Sheet Tab 53
Enter planned employee hours into a daily plan 54
1.6.4.1 Apply hours to multiple employees 54
Enter planned equipment hours into a daily plan 55

InEight Inc.  |  Release 26.3 Page 5 of 212

Progress User Guide



1.6.4.2 Remove unused tasks and resources 57
Resources Association 57

1.6.5 Quantities Tab 58
Enter planned quantities into a daily plan 59

1.6.6 Notes/Issues Tab 60
1.6.6.3 Notes 60
Create a note in a daily plan 61
1.6.6.4 Issues 63
Create an issue in a daily plan 64
1.6.6.5 Send Issue to InEight Change 65

1.6.7 Productivity Tab 66
Enter a Goal Productivity Factor for a Daily Plan 67

1.6.8 Submit a Daily Plan to Execution 68
Submit a Daily Plan to Execution 69

1.7 Vendor Use of Daily Plans 70
1.7.0.1 User and Project access 70
1.7.0.2 Resources 71
1.7.0.3 Task 72
1.7.0.4 Vendor use of daily plans 72

1.8 Management Console 75
1.8.1 Add a Toolbox Talk in the Management Console 76
1.8 Step by Step 1 — Add a Safety Toolbox Talk in the Management
Console 76

1.8.2 Attach a File in the Management Console 76
1.8 Step by Step 2 — Attach a File in the Management Console 76
1.8 Step by Step 3 — Attach a Document File in the Management
Console 77

1.9 Daily Plan Execution 79
1.10 Daily Plan Execution 80
1.10.1 Daily Plan Execution 81
1.10.2 Overview Tab 82
1.10.3 Details Tab 82
1.10.4 Time sheet Tab 83
1.10.4.1 Temporary Resources 84
Add a Temporary Resource 84

1.10.5 Quantities Tab 86
1.10.6 Notes/Issues Tab 88
1.10.7 Productivity Tab 89
1.10.8 Sign In/Sign Out Tab 89

Page 6 of 212 InEight Inc.  |  Release 26.3

Progress User Guide



1.11 Actuals 91
1.11.1 Input Actual Hours 91
Assign an Employee Resource to a Temporary Resource 91
Input Actual Hours Worked into a Daily Plan 93

1.11.2 Input Actual Quantities 94
Input Actual Quantities Installed into a Daily Plan 95

1.11.3 Add Notes/Issues 97
Add a Note to the Execution Phase of a Daily Plan 97

1.11.4 Productivity 99
1.12 Attachments on the Web 100
1.12.1 Attach a File in a Daily Plan 100
1.12 Step by Step 1 — Attach a File in a Daily Plan 100
1.12 Step by Step 2 — Attach a Document File in a Daily Plan 101
1.12 Step by Step 3 — Attach an External URL Link in a Daily Plan 102

1.12.2 Attach a File in the Management Console 103
1.12 Step by Step 4 — Attach a File in the Management Console 103
1.12 Step by Step 5 — Attach a Document File in the Management
Console 104

1.13 Sign In/Sign Out 106
1.13.1 Sign In Subtab 107

Shift Start Time 107
Employee Sign-in 107
Sign-in on Behalf of Employee 107
Questions 108

1.13.2 Breaks Subtab 108
1.13.3 Crew Break Hours 108
1.13.3.1 Shift Start/End Time 109

1.13.4 Sign Out Subtab 110
1.13.4.2 Shift Start/End Time 110
1.13.4.3 Employee Sign-out 111
1.13.4.4 Sign-out on Behalf of Employee 111
1.13.4.5 Client Sign-out 111
1.13.4.6 Questions 111

1.13.5 Time sheet Summary 112
1.13.6 Crew Hours 112
Sign Out an Employee on a Daily Plan 113

1.14 Daily Plan Approval 114
1.15 Review Actuals 115
1.15.1 Why Review Executed Daily Plans? 115

InEight Inc.  |  Release 26.3 Page 7 of 212

Progress User Guide



1.16 Employee Register 117
1.16.1 What is the Employee Register? 117
1.16.2 Why use the Employee Register? 117
Open the Employee Register 117

1.16.3 Edit Submitted Daily Plan 120
Adjust the Hours of a Signed Out Employee 120

1.17 Approve Daily Plans 125
Approve a Daily Plan 125

1.17.1 Bulk Plan approval 126

CHAPTER 2 — TIME CENTER 127
2.1 Time Center Navigation 128
2.1.1 Time Center Overview 128
2.1.1.1 Time Center Purpose 128
2.1.1.2 Display Configurations 129
2.1.1.3 Time Center Access 129

2.1.2 Time Center Register Columns 132
2.1.2.4 Sort Columns 135
2.1.2.5 Move Columns 136
2.1.2.6 Filter columns 136
2.1.2.7 Group Columns 138
2.1.2.8 Project groups 139
2.1.2.9 Unique budget code segments 141

2.1.3 Unapproved Time Cards 142
2.1.4 Date Filter 142
2.1.5 Time Card Pre-Set Filters 143
2.1.6 Query Builder 144
2.1 Step by Step 1 — Create a Query 144
2.1.6.10 Filter Indicators 146

2.1.7 Error Indicators 147
2.1.7.11 Errors 147
2.1.7.12 Warnings 148

2.1.8 Edit notes 148
2.2 Time Card Management 151
2.2.1 Time Card Management Overview 151
2.2.2 Time Card Review 151
2.2.2.1 Data Validation Errors 151
2.2.2.2 Correcting Issues Outside of Time Center 153
2.2.2.3 Correcting Issues in Time Center 153

Page 8 of 212 InEight Inc.  |  Release 26.3

Progress User Guide



2.2.2.4 Other Time Card Adjustments 154
2.2.3 Saving Changes 155
2.2.4 Add Time Card 156
2.2.5 Delete Time Card 157
2.2.6 Export Time Cards 158
2.2.7 Reallocate Time Cards 158
2.2.8 Submit to Payroll 159
2.2.9 Approval Delegation Permission 160
2.2.9.5 Integration Validation 160

CHAPTER 3 — WEEKLY TIME SHEET 163
3.1 Weekly Time Sheet Overview 164
3.2 Weekly Time Sheet Setup 165
3.2.1 Organization Setup 165
3.2.1.1 Budget Code Setup 165
Enable Unique Budget Codes 166
3.2.1.2 Organization Settings 167
Confirm Fiscal Period Settings 168
Confirm Reason Code Settings 169
Confirm Premiums and Allowances 173

3.2.2 Employee and User Setup 175
3.2.2.3 Roles 175
Review Roles 176
3.2.2.4 Users 179
Add a User Role 179
3.2.2.5 Employees 180
Review Employee Record 181

3.2.3 Project Setup 182
3.2.3.6 Project Details 182
Confirm Project Details 183
3.2.3.7 Assign Employees 184
Assign Employees to Project 184

3.3 Weekly Time Sheet Navigation 186
3.3.1 Open Weekly Time Sheet 186
3.3.2 Weekly Time Sheet Register 187

3.4 Manage TeamMembers 189
3.4.1 Manage TeamMembers 189
Manage TeamMembers 190

3.4.2 Troubleshooting 194
3.5 Manage Time Cards 195

InEight Inc.  |  Release 26.3 Page 9 of 212

Progress User Guide



3.5.1 Create Time Cards 195
Create a Time Card 195
3.5.1.1 Add & Review Notes 198
Add A NEWNOTE 199
3.5.1.2 Add Allowances 202
Add Allowances 202
3.5.1.3 Add Equipment Hours 203
Add Equipment Hours 204

3.5.2 Copy Time Cards 205
3.5.3 Review Time Cards 206
3.5.4 Submit Hours 206
3.5.4.4 Supervisor Approval 208
Edit Operational Resource 210
3.5.4.5 Automatic Time Sheet Approval 212

Page 10 of 212 InEight Inc.  |  Release 26.3

Progress User Guide



STEP-BY-STEP PROCEDURES
Create a Daily Plan Using the Daily Plan Wizard 29

Create a Daily Plan by Copying an Existing Daily Plan 39

Create a Daily Plan from Scratch 45

Open a Daily Plan 50

Enter planned employee hours into a daily plan 54

Enter planned equipment hours into a daily plan 55

Enter planned quantities into a daily plan 59

Create a note in a daily plan 61

Create an issue in a daily plan 64

Enter a Goal Productivity Factor for a Daily Plan 67

Submit a Daily Plan to Execution 69

1.8 Step by Step 1 — Add a Safety Toolbox Talk in the Management Console 76

1.8 Step by Step 2 — Attach a File in the Management Console 76

1.8 Step by Step 3 — Attach a Document File in the Management Console 77

Add a Temporary Resource 84

Assign an Employee Resource to a Temporary Resource 91

Input Actual Hours Worked into a Daily Plan 93

Input Actual Quantities Installed into a Daily Plan  95

Add a Note to the Execution Phase of a Daily Plan 97

1.12 Step by Step 1 — Attach a File in a Daily Plan 100

1.12 Step by Step 2 — Attach a Document File in a Daily Plan 101

1.12 Step by Step 3 — Attach an External URL Link in a Daily Plan 102

1.12 Step by Step 4 — Attach a File in the Management Console 103

1.12 Step by Step 5 — Attach a Document File in the Management Console 104

Sign Out an Employee on a Daily Plan 113

Open the Employee Register 117

Adjust the Hours of a Signed Out Employee 120

Approve a Daily Plan 125

InEight Inc.  |  Release 26.3 Page 11 of 212

Progress User Guide



2.1 Step by Step 1 — Create a Query 144

Enable Unique Budget Codes 166

Confirm Fiscal Period Settings 168

Confirm Reason Code Settings 169

Confirm Premiums and Allowances 173

Review Roles 176

Add a User Role 179

Review Employee Record 181

Confirm Project Details 183

Assign Employees to Project 184

Manage TeamMembers 190

Create a Time Card 195

Add A NEWNOTE 199

Add Allowances 202

Add Equipment Hours 204

Edit Operational Resource 210

Page 12 of 212 InEight Inc.  |  Release 26.3

Progress User Guide



EXERCISES

InEight Inc.  |  Release 26.3 Page 13 of 212

Progress User Guide



Page 14 of 212 InEight Inc.  |  Release 26.3

This page intentionally left blank.

Progress User Guide



CHAPTER 1 — DA ILY PLANN ING

1.1 InEight Progress Overview 17
1.1.1 InEight Progress Daily Planning Phases 17
1.1.2 Daily Plan Work Flow 18
1.1.3 InEight Control Integration 19
1.1.4 Daily Planning 20
1.1.5 Daily Execution 21
1.1.6 Daily Approval 22
1.1.7 Work Flow Beyond InEight Progress 22

1.2 Daily Plan Creation 24
1.3 Daily Plan fromWork Package (Daily Plan Wizard) 25

1.3.1 What is a Daily Plan? 26
1.3.2 Daily Plan Wizard 26

1.4 Daily Plan from Copy 36
1.4.1 Copy a Daily Plan 36

1.5 Daily Plan from Scratch 42
1.5.1 Daily Plan from Scratch 42

1.6 Completing a Daily Plan 49
1.6.1 Daily Plans Page 50
1.6.2 Overview Tab 51
1.6.3 Details Tab 52
1.6.4 Time Sheet Tab 53
1.6.5 Quantities Tab 58
1.6.6 Notes/Issues Tab 60
1.6.7 Productivity Tab 66
1.6.8 Submit a Daily Plan to Execution 68

1.7 Vendor Use of Daily Plans 70
1.8 Management Console 75

1.8.1 Add a Toolbox Talk in the Management Console 76
1.8.2 Attach a File in the Management Console 76

1.9 Daily Plan Execution 79

InEight Inc.  |  Release 26.3 Page 15 of 212

Progress User Guide



1.10 Daily Plan Execution 80
1.10.1 Daily Plan Execution 81
1.10.2 Overview Tab 82
1.10.3 Details Tab 82
1.10.4 Time sheet Tab 83
1.10.5 Quantities Tab 86
1.10.6 Notes/Issues Tab 88
1.10.7 Productivity Tab 89
1.10.8 Sign In/Sign Out Tab 89

1.11 Actuals 91
1.11.1 Input Actual Hours 91
1.11.2 Input Actual Quantities 94
1.11.3 Add Notes/Issues 97
1.11.4 Productivity 99

1.12 Attachments on the Web 100
1.12.1 Attach a File in a Daily Plan 100
1.12.2 Attach a File in the Management Console 103

1.13 Sign In/Sign Out 106
1.13.1 Sign In Subtab 107
1.13.2 Breaks Subtab 108
1.13.3 Crew Break Hours 108
1.13.4 Sign Out Subtab 110
1.13.5 Time sheet Summary 112
1.13.6 Crew Hours 112

1.14 Daily Plan Approval 114
1.15 Review Actuals 115

1.15.1 Why Review Executed Daily Plans? 115
1.16 Employee Register 117

1.16.1 What is the Employee Register? 117
1.16.2 Why use the Employee Register? 117
1.16.3 Edit Submitted Daily Plan 120

1.17 Approve Daily Plans 125
1.17.1 Bulk Plan approval 126

Page 16 of 212 InEight Inc.  |  Release 26.3

Progress User Guide



1 . 1 INE IGHT PROGRESS OVERV IEW

InEight Progress is one of the applications within the InEight portfolio of products. It is an integrated
electronic time, equipment and quantity collection tool as well as a daily field log. The InEight Progress
solution includes three submodules: Daily Planning, Weekly Time sheet and Time center. The Weekly
Time sheet and Time center solutions are covered in the Progress – Advanced User Guide. This Guide
will cover the Daily Planning portion of InEight Progress.

1.1.1 InEight Progress Daily Planning Phases

Daily planning is broken down into three distinct phases in the application: Planning, Execution, and
Approval. 

A daily plan is created by a project member to specify the tasks to be completed by a given crew, and
to ensure productivity targets are met. Budget, quantity, safety, quality and other details are entered
during the Planning phase to provide streamlined communication from the office to the field. Once the
planner, typically a superintendent, field engineer or indirect supervisor is satisfied with the daily plan
details and planned productivity, they will submit the plan to the Execution Phase.

In the Execution Phase, a project member takes the daily plan out in the field and references it
throughout the day. As work is completed, the project member enters actual hours worked for
employees and equipment. He or she also enters installed quantities, notes/issues and/or pictures to
document issues and reviews the overall productivity.  By claiming installed quantities and entering
actual hours worked, the project member can view productivity in real-time.  Once all employees have
reviewed their hours worked and signed out of the application, the daily plan is submitted for
approval.
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In the Approval Phase, a project member reviews the actual tasks, employees, equipment, hours,
quantities and productivity for the plan. In this phase, the hours and/or quantities can be approved as
is, or if the approver would like something changed, the plan can be edited or sent back to the
Execution Phase. The approver can approve the hours submitted, the quantities submitted or both.
Approving the hours will send them to payroll for processing and approving the quantities will send
them to the quantity tracking module of InEight Plan which syncs directly with InEight Control.

1.1.2 Daily Plan Work Flow

For all phases of the Daily Planning Process, InEight Progress Mobile communicates directly with the
InEight Progress Web application, as shown in the diagram below:

A daily plan can be accessed in either program in any of the phases of daily planning. The program
used for a phase may vary from project to project and depends largely on the roles of the project
members involved. For example, it may be preferable to have a staff member such as a superintendent
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or engineer complete daily planning in the InEight Progress web application because they prefer to
work from a computer in an office location. The Execution Phase of that same daily plan may be
completed by a foreman who spends their entire workday out on the jobsite without access to a
computer. In this case the Execution Phase is completed in the InEight Progress mobile application.
Finally, the superintendent or engineer may also be responsible for approval of the daily plan which
would again be completed in the InEight Progress Web application from their office computer.

Mobile Daily Planning has all the same functionality as Web Daily Planning for InEight Progress,
but is available as a mobile-only application. 

1.1.3 InEight Control Integration

WBS (work breakdown structure) elements are used to link the quantity, hours and cost captured in
InEight Progress with the cost elements in InEight Control. InEight Control communicates the WBS
Structure (including budgeted quantities, hours and cost) with InEight Plan. InEight Plan then assigns
WBS elements to components. 

InEight Progress uses the component quantities along with actual hours to determine productivity.
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This lesson provides an overview of InEight Progress and the subsequent lessons will expand on the
InEight Progress functionality in more detail.

1.1.4 Daily Planning

Daily planning offers specific functionality for project members to create, view, or change daily plans as
needed. Daily plans allow you to select specific components and resources (labor and equipment) from
a work package and assign it in daily production increments. 

Daily Planning is completed by navigating through the six tabs in the navigation bar at the top of the
screen:

l Overview – Modify or enter plan details, approvers, and executors

l Details – Enter planner notes and tool box talk items
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l Time Sheet – Select tasks and resources and assigned planned hours

l Quantities – Select specific components and specify planned installation quantity

l Notes/Issues – Enter any additional plan notes/issues including photos if needed.

l Productivity – Review planned productivity and compare against current budget or estimate or
current estimate

A foreman can also use mobile daily planning to change an existing daily plan.  If the plan
changes from the original plan, a foreman can still make changes to the daily plan.

1.1.5 Daily Execution

Daily execution allows you to capture actual hours, quantities, notes/issues, and productivity.  You can
document the number of hours worked for each employee and machine assigned to a specific task.
(For hourly rates, you can document standard time [ST], over time [OT], or double time [DT]).

You can claim the quantity completed and see the productivity for the day. You can also add notes and
pictures. Once you complete the entries, you can sign out employees and fill out compliance
questionnaires. This is commonly used to ensure at sign off that employees are not injured while at
work.

Daily execution is completed by navigating through the seven tabs in the navigation bar at the top of
the screen:

l Overview – Review plan details, approvers, and executors

l Details – Review planned tasks, planner notes and tool box talk items

l Time Sheet – Enter actual hours worked and assign to tasks and resources

l Quantities – Enter actual components and indicate installed quantity

l Notes/Issues – Enter any notes/issues and photos related to execution of the work

l Productivity – Review actual productivity and compare with current budget, estimate and
planned production rates

l Sign Out – Review employee hours, enter sign out pin or signature and answer compliance
questions
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1.1.6 Daily Approval

Daily approval allows you to review actual hours, quantities, notes/issues, and productivity that were
entered during the execution phase. This gives supervisors a chance to review information before the
hours are sent to the ERP payroll system and quantities are claimed in InEight Progress. 

There are 3 options in the Approval Phase:

l Approve - Quantities and hours can be approved independently or all at once

l Edit – The daily plan can be further edited by the Approver to change specific details such as
tasks, resources, hours and quantities

l Reject – Sends the daily plan back to Execution Phase to allow the Executor to revise the plan
and resubmit

All tabs from the Execution Phase can be viewed in the Approval Phase.

1.1.7 Work Flow Beyond InEight Progress

When quantities are approved in Progress, they can be brought into the InEight Control application
(initiated within InEight Control). 

1.1.7 .1 Hours

When hours are approved, the hours are sent to your payroll system. Once ERP payroll has processed
the hours, as-built hours and costs can then be pulled into InEight Control from ERP payroll (again
initiated in InEight Control). 

1.1.7 .2 Quant i t ies and Costs

Bringing actual installed quantities and as-built costs into InEight Control allows you to monitor and
compare actual costs and productivity against budgets for all cost accounts. It also helps provide timely
information to accurately forecast costs.

The following diagram illustrates the workflow of InEight Progress in relation to other products within
the InEight portfolio and the ERP system. You will reference this diagram throughout the course.
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1 . 2 DA ILY PLAN CREAT ION
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1 . 3 DA ILY PLAN FROM WORK PACKAGE
(DA ILY PLAN WIZARD)

Scenario

Tomorrow, your crew will be starting the steel erection work on your module. You are now ready
to plan the work for your crew. During this first day, you want your crew to install the A7
connections to foundations. Your crew will consist of a Grove-RT880E crane, 3 Ironworkers and 1
Laborer. You want to make sure to communicate the work to your crew and identify safety
concerns for the day.

In this topic, you will create a daily plan from an already existing work package using the Daily Plan
Wizard in the InEight Plan web application.
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1.3.1 What is a Daily Plan?

After you put your work package together, you break it down into daily segments, or the work you plan
to accomplish in a given day.

Using the scenario above as an example, your steel erection work package for your module will take
multiple days to complete. You will use daily planning to plan the work in the sequence you are looking
to do it in, day by day. Daily planning is a good tool to communicate to your crew your safety concerns,
quality and environmental risks, and expected productivity.

Daily planning combines:

l Components

l Activity components

l Material components associated with WBS

l Resources (employees, and equipment)

l Planned hours

l Planned quantities

l Notes/Issues

l Attachments (for example, safety notes, plan specifications)

1.3.2 Daily Plan Wizard

The Daily Plan Wizard is a powerful tool that can help automate the process of setting up daily plans by
copying information from an already existing work package to avoid duplicate work.  The Daily Plan
Wizard allows you to choose which parts of the work package will be brought into the daily plan.

You access the Daily Plan Wizard from Plan Work packaging module.

Title Description

1 Plan date The date that the plan will be executed.

2 Plan name Unique name for the daily plan.

Overview – Daily Plan Wizard
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Title Description

3 Shift A drop-down field where you can select either First, Second or Third
Shift.

4 Work
plan/package
ID-Name

This should be automatically populated with the name of the work
plan/package that the current daily plan is being created from.

5 Planner notes A free text field where any relevant notes can be added in.

6 Location A free text field where the location of where the work will be performed
can be entered.

7 Approvers From the drop-down field, you can add the responsible approver(s) of
the daily plan. Superintendent or Engineer is a common choice.

8 Executors From the drop-down field, you can add the assigned user responsible
for executing the daily plan.

9 Associated
vendor

Select a vendor from the drop-down list. Available vendors are
populated based on vendor associations for your project in InEight
Control.Provides different options of how to complete the daily planning
process: includes Create Plan, Cancel, and Skip Planning.

Overview – Daily Plan Wizard (continued)
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The following Step by Step walks you through how to use the Daily Plan Wizard. 

This Step by Step assumes you already have a work package (CWP or IWP) created containing
work package details (e.g., labor, equipment, components, safety). See Work Package Creation
for details on setting up work packages.
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Create a Daily Plan Using the Daily Plan Wizard

1. From your project home page, navigate to Plan >Work packaging.

2. From the Work Packages tab, open a Construction Work Area (CWA) and click on the arrow in
the ID column of your Construction Work Plan (CWP) to extend the work package below.

3. Select a Construction Work Package (CWP) by clicking on its hyperlink ID.

4. Open your Installation Work Package (IWP) by clicking on its hyperlink ID.
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5. From the IWP page, click on theWorkspace tab.

6. Click on the Daily Plan icon.

l This opens the Daily Plan Wizard slide-out panel
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7. With the Daily Plan Wizard open, select the components, resources, etc. that you want to copy
by clicking on the calendar icon from your data blocks.

l Your selections are shown in the Wizard

Not all data blocks can be copied. If no calendar icon is shown, that data block is not
available to be populated in daily planning. Activity components can only be used if they
can be claimed in Plan Quantity tracking. Labor and equipment can only be used if they
are active in the project date range.

8. When finished, click Next on the Daily Plan Wizard.
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9. Enter your new daily plan details.

You can complete and edit these daily plan details at any point. Notice that only some
fields are required to create a new daily plan.
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10. Click Next.

11. Confirm that all your selected components and resources are correct for your new daily
plan. Then, click Next.
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12. Verify that everything is correct for the Tool box talks section. Then, click Create plan.
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l Once created, you can edit your new daily plan by navigating to Progress > Daily
Planning page > My Daily Plans Tab
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1 . 4 DA ILY PLAN FROM COPY

In this topic, you will create a daily work plan as a copy of an already existing daily plan.

1.4.1 Copy a Daily Plan

In some cases, you will need to create a very similar daily plan for multiple days with only a few small
changes from day to day. Instead of performing the entire process of creating a daily plan from a work
package multiple times, the best process would be to:

1. Create one daily plan using the Daily Plan Wizard.

2. Create a copy of that daily plan.

3. Make changes as necessary for each subsequent day.

The process to create a copy of an already existing daily plan is like that of using the Daily Plan Wizard.
You will need to fill out a window similar to the wizard; however, this window will give the option to
copy over all the information you entered in the Planning Phase. 

Title Description

1 Plan date The date that the plan will be executed.

2 Plan name Unique name for the daily plan; this will auto populate with copy –
[name of plan you just copied] and should be edited to your desired
daily plan name.

3 Multiple days Specify how many days to copy a daily plan to starting with the
entered plan date. You can also select whether to exclude weekends.
You can copy to a maximum of 99 days.

4 Work
plan/package
ID-Name

You can enter a work plan ID here if you want the plan to reference
an existing work plan/package.

5 Planner notes A free text field where any relevant notes can be added in.

6 Shift A drop-down field where you can select either First, Second or Third

Overview – Copy Daily Plan Window
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Title Description

Shift.

7 Location A free text field where the location of where the work will be performed
can be entered.

8 Include the
following check
boxes

Allows users to select which attributes from the plan that is being
copied will be populated in the new plan.

9 Associated
vendor

From the drop-down list, you can associate a vendor assigned to the
project in InEight Control.

10 Approvers From the drop-down list, you can add the responsible approver(s) of
the daily plan. Superintendent and/or Engineer is a common choice.

11 Executors From the drop-down list, you can add the assigned user responsible
for executing the daily plan.

Overview – Copy Daily Plan Window (continued)
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The following Step by Step walks you through how to create a copy of a daily plan.
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Create a Daily Plan by Copying an Existing Daily Plan

1. From the Daily Plans page, check the box in the far-left column of your daily plan to select it.

2. Click on the Copy icon on the toolbar.

l This will open the Copy Daily Plan pop up window

3. Rename your new plan.
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4. Click on the Calendar icon in the Plan Date Field and select a date.

5. Select a shift from the shift drop-down menu.

l The Work Plan ID, Approvers, Executors, Location and Shift should all be auto-populated
with the same values as the plan you copied. Do not change these fields
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l When copying break and shifts, the resource hours are copied to the break and shift
details in the new plan.

6. Enter any notes the Planner notes field.

7. Verify all check boxes are selected in the section called Include the following.

The Premiums check box is only enabled if the Resources, Extra pay, and Resource hours
check boxes are selected.

8. Click Create Plan.

Do not click on the Skip Planning button. This pushes the daily plan directly to the
Execution phase.

At this stage, an exact replica of your existing daily plan has been created.  All tasks,
components, employees, equipment, notes, planned quantities and tool box info has been
copied over
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1 . 5 DA ILY PLAN FROM SCRATCH

In this topic, you will create a daily plan from scratch utilizing the InEight Progress web application.

1.5.1 Daily Plan from Scratch

In some cases it may be necessary to create a daily plan without a work package or other daily plan to
use as a starting point. In this case, you will need to create a daily plan from scratch. The biggest
difference between creating a daily plan from scratch and the other two methods covered earlier is
that you must add all resources, tasks, and components to the plan manually.

When creating a daily plan from scratch, you will use the Add daily plan window. This window is very
similar to the Daily Plan Wizard covered earlier in the lesson, except there is only one tab for entering
setup information.

1.5.1 .1 Approver and Executor Roles

Depending on the project settings of your project, your daily plans will require an Approver and/or an
Executor. You select Approvers and Executors from a drop-down list of the users assigned to your
project.
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When deciding on Approver and Executor roles for daily plans, it is important to note that if you use
both an Approver and Executor for your daily plans, only the Approvers can have permissions to
approve daily plans. Executors must NOT have permissions to approve daily plans.

For example, your project administrator may plan to only allow employees with the Superintendent
role to act as Approvers on daily plans. Under the permissions for the Superintendent role, your
administrator would ensure that the Approve daily plan permissions are enabled.

If you planned to allow employees assigned to the Foreman role to act as Executors for daily plans,
your project administrator would need to edit the Foreman role to make sure the Approve daily plan
permissions are UNCHECKED.

1.5.1 .2 Vendor assoc ia t ion

In InEight Control, you can assign vendors to individual cost items to indicate that a certain scope of
work will be completed by a third-party vendor. That vendor data can be used in daily planning.

You can associate vendors to a daily plan using the Associated vendor field. Select a vendor from the
drop-down list. Available vendors are populated based on vendor associations for your project in
Control.
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Title Description

1 Plan date The date that the plan will be executed.

2 Plan name Unique name for the daily plan.

3 Shift A drop-down field where you can select either First, Second or Third
Shift.

4 Work
plan/package
ID-Name

You can enter a work plan ID here if you want the plan to reference an
existing work plan/package.

5 Planner notes A free text field where any relevant notes can be added in.

6 Location A free text field where the location of where the work will be performed
can be entered.

7 Approvers From the drop-down field, you can add the responsible approver(s) of
the daily plan. Superintendent or Engineer is a common choice.

8 Executors From the drop-down field, you can add the assigned user responsible
for executing the daily plan.

9 Associated
vendor

Select a vendor from the drop-down list. Available vendors are
populated based on vendor associations for your project in InEight
Control.

Overview – Add Daily Plan Window

Page 44 of 212 InEight Inc.  |  Release 26.3

1.5 Daily Plan from Scratch Progress User Guide



The following Step by Step walks you through how to create a daily plan from scratch.

Create a Daily Plan from Scratch

1. From the Daily Plans page, click the Add icon in the upper left corner.

l This opens the Add daily plan window

2. Click on the Calendar icon in the Plan Date field and select a date.
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3. Name your daily plan.
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l Leave the Work plan ID field blank

4. Select a shift from the drop-down menu of the Shift field.

5. Enter any notes in the Planner notes field.
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6. Click Add approver and select someone from the drop-down menu.
l You may need to search for the name

7. Click Add executor and select someone from the drop-down menu.

8. Click Create Plan.

Do not click on the Skip Planning button; this will push the daily plan directly to the
Execution Phase.
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1 . 6 COMPLET ING A DA ILY PLAN

Scenario

You have just finished creating a new daily plan using the Daily Plan Wizard. However, some
specific information was not available on the work package. You will now add this information to
inform your crew.

Once you finish creating your daily plan via the Daily Plan Wizard, the next step is to assign specifics to
your plan. In other words, even though you already populated the basic information via the Daily Plan
Wizard you are still missing some important information required to execute the intended work. For
example, you still need to enter the planned quantities or components and claiming steps to be
completed and hours each employee and/or piece of equipment will work for the day.

This planning phase is crucial to making sure the work executes efficiently and on budget. To complete
this phase, you'll move from InEight Plan to InEight Progress.

Title Description

1 Main Menu Shows the selected project and provides access to favorites, All
projects and organizations, reports, master data libraries, and suite
administration.

2 Home Opens your user home page.

3 Notifications and
User Profile

Allows you to view notifications and your user profile or to log out.

4 App launcher Opens applications and modules.

5 Breadcrumbs Navigational links that allow you to track your path from the page you
are currently viewing back to the daily plans page. Furthermore,
identifies what and where you are within the daily planning module.

6 Tabs Allow you to navigate between different functions on a page. The
blue underline indicates what tab you are currently viewing.

7 Toolbar Contains functions for the page you are on: add, edit, delete, copy,
and Employee Register.

InEight Inc.  |  Release 26.3 Page 49 of 212

Progress User Guide 1.6 Completing a Daily Plan



Title Description

8 Daily Plan
Register

Contains a list of all your daily plans.

9 Column Chooser Allows you to add or hide columns from your user specific register
view.

(continued)

1.6.1 Daily Plans Page

To begin the Planning Phase of a daily plan, you must first open a daily plan. In the following Step by
Step, you will navigate to the Daily Plans page and then open a daily plan. 

Open a Daily Plan

1. From your project home page, open the Daily planningmodule of Progress. The Daily plans page
opens to a list of your daily plans.

2. Click on your daily plan's name.
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When opened for the first time, a daily plan is in the planning phase by default and opens to the
Details tab. In the planning phase, there are six different tabs where you can enter plan information.

Dai ly Plan rev iew

In Daily Plan Review, you can select employees or equipment and filter by date. A live report shows all
resources that are being used. You can make adjustments by clicking the plan name.

The following sections give an overview of each tab of the Planning Phase of the daily plan and include
Step by Steps to enter additional information where applicable. 

1.6.2 Overview Tab

The Overview tab provides a summary level of all information related to the current daily work
plan. The fields on this tab lets you modify basic daily plan information, approvers, executors, and
associated work plans and vendors.
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1.6.3 Details Tab

The Details tab is the default tab that displays when you open a daily work plan. The Details tab
provides a summary level of all information related to the current daily work plan. This includes the
capability to modify the plan description, plan date, location, approvers, executors, and work
plan/package number.

Title Description

1 Overview
data block

Shows the tasks, employees, hours, and quantity you are planning on
having or completing the next day. This is a useful tool for the foreman to
review with their crew as a morning meeting.

2 Tool box
talks data
blocks

Provides important messages on the concerns and mitigation measures
for various risks which should be reviewed by your crew.

3 Planner
notes data
block

Lets you enter daily plan notes in an easily accessible section.
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1.6.4 Time Sheet Tab

The Time Sheet tab is primarily used for entering the planned man-hours for each resource on each
task. You can also add resources and tasks to the daily plan in this tab as needed. You can also add
notes and assign or tag them to specific tasks or resources in this tab.

Title Description

1 Task columns All tasks that are to be worked are shown here.

2 Resource rows All resources being used are shown here.

3 Hours entry area Hours for each resource on a given task are entered here.

InEight Inc.  |  Release 26.3 Page 53 of 212

Progress User Guide 1.6 Completing a Daily Plan



The following steps walk you through entering planned employee hours into a daily work plan. You
must have added an employee and a task to the time sheet.

These steps assume that your project has reason codes enabled. If you do not use reason codes,
the labor hours entry dialog box looks slightly different.

Enter planned employee hours into a daily plan

1. Open your daily plan.

2. Click on the Time sheet tab.

3. Click in the hours entry cell for your first listed worker. The Labor Hours dialog box opens.

4. Click the Add icon, and then select a reason code.

5. Enter the number of hours you expect the employee to work in the blank field, and then click
Done.

You can also click the Premiumsicon to apply premiums to hours if they are set up for
your project.

1.6.4 .1 Apply hours to mul t ip le employees

You can apply hours to multiple employees on the web. When you click the intersection of an
employee and a task, the Employee hours dialog box now has the following options:
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l Apply hours to selected employees: This option lets you select the intersections of employees
and tasks to apply the entered hours. When you are finished selecting intersections, click Done.

l Apply hours to all employees for the task: This option automatically applies the entered hours to
all employees.

The following steps walk you through entering planned equipment hours and operator hours for an
employee into a daily plan. You must have added an employee, a piece of equipment, and a task to the
time sheet.

These steps assume that your project has reason codes enabled. If you do not use reason codes,
the labor and equipment hours entry dialog boxes look slightly different.

Enter planned equipment hours into a daily plan

1. Open your daily plan.

2. Click on the Time sheet tab.
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3. Click in the hours entry cell for your first listed worker. The Labor Hours dialog box opens.

4. Click the Add icon, and then select the Operate Equipment reason code. Click Done.

The Operate Equipment reason code might be called something different depending on
how reason codes are set up for your organization.

5. Enter the number of hours you expect the employee to operate the equipment in the blank field.

6. Click the Equipment icon, and then select the piece of equipment the employee will be
operating. Click Done.

Click Done.

You can also add equipment hours without an operator by clicking the hours entry field for the
equipment, and then adding hours only to the equipment.
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1.6.4 .2 Remove unused tasks and resources

You can remove all unused tasks or resources from a daily plan at the same time. At the top of the
Time Sheet tab, click the Remove unused tasks and resources icon, and then select one of the
following options:

l Remove unused resources: All employees with no daily plan data associated with them are
removed from the daily plan.

l Remove unused tasks: All tasks with no daily plan data associated with them are removed from
the daily plan.

Resources Assoc ia t ion

When adding resources in time sheets, you can access associated work packages. When selected and
added to the plan, the associated work packages will no longer show. A work package in IWP must
have resources, equipment, labor, or components with tasks or WSB associations, to bring values into
the relevant fields.

InEight Inc.  |  Release 26.3 Page 57 of 212

Progress User Guide 1.6 Completing a Daily Plan



1.6.5 Quantities Tab

The Quantities tab is where you can view, add, or remove the components assigned to each task in
your daily plan. The Quantities tab is also where you input the planned quantities to be installed for
each component.

Title Description

1 Task list Where all tasks assigned to the daily plan are listed. Tasks can also be
added or removed here. The task on the quantities tab corresponds with
the task column on the time sheet tab. Populating additional task in
either location populates it in the other.

2 Components
list

Where all components for each task assigned to the daily plan are
listed. Components can also be added or removed here.

3 Contracts list Where all contracts assigned to the daily plan are listed. Contracts can
also be added or removed here. If contracts are not available, this area
is not shown.
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The following steps walk you through how to input the planned quantity for components into a daily
plan.

Enter planned quantities into a daily plan

1. Open your daily plan.

2. Click the Quantities tab.

3. In the components list, click the arrow next to your claiming scheme.

4. Select the Complete check box for the completed steps of the claiming scheme.

Selecting Complete indicates you plan for 100% of that step to be completed that day
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To calculate a breakdown of the cost and component quantities of a selected task, select the

slide-out panel icon

1.6.6 Notes/Issues Tab

The Notes/Issues tab is where you can enter additional important information pertaining to the daily
plan. You can associate notes and issues to specific tasks, employees, equipment, and components as
needed. You can also tag notes and issues to group them by a variety of topics such as quality, safety,
environmental, and more.

Title Description

1 Toolbar Use the icons in the top toolbar to add, edit, or delete notes or
issues.

2 Timeline This is where all notes for a daily plan display in a chronological
order, with most recent at the top.

3 Notes/Issues
Creation Area

This is where notes and issues are created.

1.6.6 .3 Notes

Notes can be added directly from the Notes/Issues tab or through the Time Sheet or Quantities tabs
and are visible to all team members with access to the daily plan.
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The following steps walk you through how to create a note from the Notes/Issues tab.

Create a note in a daily plan

1. Open your daily plan.

2. Click the Notes/Issues tab.

3. Click the Add icon in the upper left, and then select Add note.

If there are no existing notes, you can also click Add note in the creation area on the right.

4. Enter a description in the text field.

5. To add a tag, click Add tags, and then select a tag in the slide-out panel. Click Done to close the
slide-out panel.

Tags are defined by your organization and project.

6. To add an association, click Add associations. From the slide-out panel, click the tabs at the top
to choose a category. Select tasks, employees, equipment, components, maintenance orders, or
vendors to include as an association. Click Done to close the slide-out panel.
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7. To attach photos to the note, click Browse Photos, and then select an image file. You can also
drag and drop an image into the field.

8. Click Done.

When integrated with InEight Document, pictures uploaded to Daily Plan notes or issues
can be automatically imported to the associated InEight Document project Gallery.

Notes can also be added from other tabs in a daily plan. To add a note from the Time Sheet tab, select
a resource and click Add note.
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To add a note from the Quantities tab, click the Add notes icon from the top right of a component.

Some actions are automatically recorded on the Notes/Issues tab, such as adding allowances,
attendance notes, or modifying time sheet details on the Sign In/Sign Out tab.

1.6.6 .4 Issues

An issue has the potential to become a change order and is indicated with an exclamation mark.
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Adding an issue is like adding a note in a daily plan. Follow the steps below to create an issue from the
Notes/Issues tab.

Create an issue in a daily plan

1. Open your daily plan.

2. Click the Notes/Issues tab.

3. Click the Add icon in the upper left, and then select Add issue.

If there are no existing notes, you can also click Add issue in the creation area on the
right.

4. Enter a name and start date for the issue, and then select the associated task from the Task
drop-down menu.

5. Enter additional details in the text field.

6. To add a tag, click Add tags, and then select a tag in the slide-out panel. Click Done to close the
slide-out panel.
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Tags are defined by your organization and project.

7. To add an association, click Add associations. From the slide-out panel, click the tabs at the top
to choose a category. Select tasks, employees, equipment, components, maintenance orders, or
vendors to include as an association. Click Done to close the slide-out panel.

8. To attach photos to the issue, click Browse Photos, and then select an image file. You can also
drag and drop an image into the field.

9. Click Done.

1.6.6 .5 Send Issue to InEight Change

If your organization uses InEight Change, issues generated in Progress are sent to Change for review,
and can be associated with change orders.
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After an issue is created, the issue shows in the Timeline section of the Notes/Issues tab. The issue is
sent to Change after the daily plan is approved.

When the issue requires immediate attention, click Send issue to immediately send the issue to InEight
Change for review.

1.6.7 Productivity Tab

On the Productivity tab, you can:

l Toggle the view to see planned production by man-hours per quantity or quantity per man-
hours.

l View the planned gain/loss in both dollars and man-hours against the current estimate, current
budget, forecast, actuals, or goals, . Selecting the goals option will allow you to manually input a
goal unit rate to compare planned and actual crew performance against.

l View the Planned G/L.

Title Description

1 Summary View a summary of the planned quantity, unit of measure and man
hours for each task.

2 Productivity
toggle

Switch the view to see planned production by man-hours per quantity
or quantity per man-hours.

3 Productivity
factor

View the gain/loss versus current estimate, current budget, forecast,
actuals, and goals, in both dollars and man-hours.
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Title Description

4 Planned G/L
calculator

Contains comparison formulas for the costs and man hours of your
plan and your budget.

(continued)

The Planned G/L compares the cost and man-hours of your daily plan to the costs and man-hours
budgeted in InEight Control for the planned scope of work using the following equations:

l Planned Cost G/L = (Sum of (Total planned quantity for the WBS * CE/CB/Forecast/Goals final
unit cost) - (Planned total cost of labor + Planned total cost of equipment))

l Planned total cost of labor = Sum of Total number of hours worked by the employee * Hourly rate
of the employee

l Planned total cost of equipment = Sum of (Total number of equipment hours operated * Hourly
Unit rate of the equipment)

The following steps walk you through how to enter a goal productivity factor for a daily plan.

Enter a Goal Productivity Factor for a Daily Plan

1. Open your daily plan.

2. Open the Productivity tab. If needed, click the Productivity toggle button to switch to MHRs per
Qty.

3. Click the Current Budget column header.

4. Select Goals from the drop-down list.
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5. Enter your goal number rate of man hours per quantity in the free text box under the Goals
column header.

1.6.8 Submit a Daily Plan to Execution

Once you have thoroughly filled out the daily plan, the final step is to submit the plan for execution. By
submitting the plan to execution, you are ending the Planning Phase and verifying that the plan is
ready to be handed off to a foreman for his crew to execute the work. Once you submit the plan, you
cannot “un-submit”.

The following Step by Step walks you through how to submit a daily plan to the Execution Phase.
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Submit a Daily Plan to Execution

1. Open your daily plan.

2. Click Submit in the upper right corner.

l A dialog box opens verifying you want to submit the plan to execution

If you want to associate your work packages in InEight Document, select a Work
plan or package ID - Name from the Overview tab. A new Document icon appears in
the upper-right corner of the tab. Select this icon to see a drop-down list of work
packages to open in Document.

3. Click Yes.
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1 . 7 VENDOR USE OF DA ILY PLANS

It might make sense for vendors to have access to track their own work on daily plans in Progress. To
limit vendor access to only the tasks and resources that pertain to them, InEight applications must be
configured as indicated below.

1.7.0 .1 User and Pro jec t access

The vendor must be assigned to the user that will be accessing Progress, and to the applicable project.

You can control what level of daily plan access the vendor has through the role assigned to them. For
example, as the contractor you might have the vendor submit time to one of your employees for
approval, so you limit their role to not have permissions to approve daily plans. In other cases, it might
make sense for the vendor to approve their own daily plans, so you enable the Approve daily plan
permissions for the vendor role.

You can edit permissions for the vendor’s role under Suite administration > Roles and permissions >
Edit role. Under the Progress menu, you can enable and disable permissions to add, edit, delete, or
approve daily plans, either assigned to the user or others.

Note that daily plans require both a foremen and superintendent assignment when adding a daily plan.
The applicable users with these roles must be assigned to the vendor and the project for the vendor to
access them when adding daily plans.

Page 70 of 212 InEight Inc.  |  Release 26.3

1.7 Vendor Use of Daily Plans Progress User Guide



1.7.0 .2 Resources

The vendor only has access to the operational resources (employees, equipment) they are assigned to.
Under Master data libraries > Operational resources > Employees, crafts must be created as needed
for the vendor, and with the vendor assigned.

All employees assigned to that craft inherit that vendor assignment.

Similarly, under the Equipment tab, models and types must be created for the vendor and with the
applicable vendor assigned.
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1.7.0 .3 Task

The tasks available to select on a daily plan come from the WBS phase code and related cost item in
Control. The vendor can only view the WBS/cost items they are assigned to in the Control application.

On the Control > Workspaces > CBS tab, the Assigned vendor column can be added to a data block and
the vendor assigned to the items they need access to on a daily plan.

1.7.0 .4 Vendor use of da i ly p lans

With the above configurations in place, when the vendor logs in and creates a daily plan, they can only
view the tasks and resources assigned to them, and are limited in their ability to plan, execute and
approve daily plans based on the permissions assigned to their role.

When adding a daily plan, the vendor assigns the applicable superintendent and foreman to the daily
plan.
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On the Time Sheet tab, when the vendor selects Add tasks and resources, they can only view the tasks
that were assigned to them in Control.

Under the Employee and Equipment tabs, vendors can only view the resources assigned to them in the
Operational resources master data library.
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The vendor can execute and approve daily plans according to the agreed upon work flow for the
project.
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1 . 8 MANAGEMENT CONSOLE

The Management console gives you one location to manage attachments and toolbox talks for general,
safety, environmental, and quality topics. The console lets you add these items and apply them to
multiple daily plans at the same time.

To open the Management console, select at least one daily plan from the Daily planning home page,
and then click Edit multiple.

The Management console has three panels:

1. The left panel is a menu of options you can manage. The options include:

l Toolbox talks - Safety

l Toolbox talks - Quality

l Toolbox talks - Environmental

l Toolbox talks - General discussion

l Attach and link files

2. The center panel lets you add toolbox talks or attachments to daily plans in the right panel.

3. The right panel lists the available daily plans to add toolbox talks or attachments to out of the
plans that you select from the Daily planning home page.

Only plans that can be edited are shown in the right panel.
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1.8.1 Add a Toolbox Talk in the Management Console

The following Step by Step shows you how to add a toolbox talk for safety to multiple daily plans at the
same time.

1.8 Step by Step 1 — Add a Safety Toolbox Talk in the Management Console

1. From the Daily planning home page, select at least one daily plan, and then click Edit multiple.

2. In the left panel of the Management console, click Toolbox talks - Safety.

3. In the center panel, fill out the Safety Concern andMitigation fields, and then click Add to all
daily plans.

You can also add multiple toolbox talks at the same time. Click the Add icon under the toolbox
talk to add another.

You can also select specific plans in the right panel, and then click Add to selected daily plans.

1.8.2 Attach a File in the Management Console

The following Step by Step shows you how to attach files from your machine using the Management
console to all selected daily plans.

1.8 Step by Step 2 — Attach a File in the Management Console

1. From the Daily planning home page, select at least one daily plan, and then click Edit multiple.

2. Click Attach and link files in the left panel of the Management console.

3. In the center panel, click SELECT FILES, and then select a file from your device.
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You can also drag and drop files into the Management console.

4. Click Add to all daily plans.

You can also select specific plans in the right panel, and then click Add to selected daily plans.

To remove an attachment from a daily plan, click the Delete icon next to the attachment in the right
panel.

The following Step by Step shows you how to attach files from InEight Document using the
Management console to all selected daily plans.

1.8 Step by Step 3 — Attach a Document File in the Management Console

1. From the Daily planning home page, select at least one daily plan, and then click Edit multiple.

2. Click Attach and link files in the left panel of the Management console.

3. In the center panel, click Link from InEight Document. You can set filter criteria to narrow the list
of records from Document.

4. After you set filter criteria, click Apply. Related Document records are shown in the table.
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5. Select one or more records, and then click Attach to all daily plans.

You can also select specific plans in the right panel, and then click Attach to selected daily
plans.

To remove an attachment from a daily plan, click the Delete icon next to the attachment in the right
panel.
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1 . 9 DA ILY PLAN EXECUT ION
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1 . 10 DA ILY PLAN EXECUT ION

Scenario

You are a field engineer working on a project that includes the erection of steel members for a
steel support structure. Your daily plan is to erect A7 connections to foundation with a Grove -
RT880E crane. Your foreman is absent for the day. With him being out, it is your responsibility to
handle the Execution Phase of his daily plan. The Execution Phase includes reviewing the plan at
the start of the day for any mistakes, entering all actual hours and quantities at the end of the
day, and finally signing out all employees so the daily plan can be submitted for approval. You do
not have an iPad; therefore, you will have to execute the daily plan in the InEight Plan application
on the web. 

l Randy Kielly – Ironworker Foreman
l Kenneth Moore – Carpenter
l Troy Brown – Ironworker
l Joseph Kelly – Ironworker
l John Walsh Jr – Ironworker

Page 80 of 212 InEight Inc.  |  Release 26.3

1.10 Daily Plan Execution Progress User Guide



In this topic, you will review a daily plan in the Execution Phase in detail and make changes to the plan
throughout the day to reflect what actually occurred.

To follow the scenarios or Step by Steps in this phase, you must submit your daily plan.

1.10.1 Daily Plan Execution

In the Execution Phase, a daily plan has the following tabs:

l Overview

l Details

l Time sheet

l Quantities

l Notes/Issues
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l Productivity

l Sign In/Sign Out

In the Execution Phase of a daily plan, you will notice all system accents change to green and in
the breadcrumbs area next to the plan name, it will now say Execution.

It is a best practice for the plan executor to review a daily plan to examine each tab and verify
understanding of all task, notes, tool box talks and planned quantities before executing the work. If any
information is confusing, incorrect or missing, they should consult the planner or supervisor and
modify or add to the daily plan as needed.

The following sections walk you through what has changed on each tab from the Planning Phase to the
Execution Phase, as well as provide some information on how to add or edit information during the
Execution Phase.

1.10.2 Overview Tab

The Overview tab maintains the same information from the Planning to Execution phase.

1.10.3 Details Tab

The Details tab is almost identical to the Details tab in the Planning Phase. The only difference is you
can no longer edit the Planner Notes field and it contains all the notes made during the Planning Phase. 

Like the Planning Phase, under the Tool box talks section, you can add, edit and delete items for each
of the four different areas (Safety, Quality, Environmental, and General discussion). 
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1.10.4 Time sheet Tab

The Time sheet tab is identical to the Time sheet tab in the Planning Phase, the only difference being
that it shows all hours assigned to each resource/task in the Planning Phase. You can edit, delete, or
add tasks, labor, and equipment to reflect the employees/equipment and task completed over the
course of the day.

This is where you input actual hours, which will be covered in detail in the next topic of this lesson.
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1.10.4 .1 Temporary Resources

Going back to the scenario at the start of the lesson, while reviewing your daily plan, you notice that
Kurt Fleming has not been included in the plan during the Planning Phase. This is because today is his
first day and he is not in the payroll system yet, but you would still like to be able to include him in the
plan for the day. Within the Progress web application, you can do this by creating a temporary labor
resource for Kurt and then swapping him out with his actual resource once it has been created in
payroll.

The following Step by Step walks you through how to add a temporary labor resource.

Add a Temporary Resource

1. From the Daily Plans page, open your daily plan.

l A prompt appears stating that the plan is in the Execution Phase

2. Click on Time sheet tab.

3. Click on the Add tasks and resources button on the left.
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4. On the resulting slide out panel, click on the Employee tab.

5. Click on Add temporary employee at the bottom of the screen.

6. In the Temporary employee name field, enter a temporary employee's name.
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7. Click Add.

8. Click Done to close the slide out panel.

l The temporary resource is added to the time sheet

1.10.5 Quantities Tab

The Quantities tab is identical to the Quantities tab in the Planning Phase. However, when viewing the
claiming schemes of the components in the daily plan, instead of the Planned quantity field being the
only editable field, now the only editable field is the Installed quantity field.

Installed quantities will be entered in the next topic of this lesson. 

At this point, tasks and contracts can only be added, not deleted; components can still be added or
deleted as needed.
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Arrow-shaped visual indicators show which items have been claimed against in the Task, Contract, and
Components lists. Green arrows indicate the tasks, contracts, and components that have been claimed
with a positive installed quantity. A red arrow indicates a negative quantity has been claimed. No
arrow indicates nothing has been claimed yet for that task, contract, or component.

You can also favorite certain components that you know you will be using frequently by clicking on the
star-shaped icon next to the corresponding component. When selected, these components move to
the top of the list eliminating the need to scroll through a long list of items.
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You can delete tasks in the Time sheet tab if needed.

You can also view and add notes and issues to components. If there are notes or issues associated with
a component, you can see them on the Quantities tab when you click the Add notes icon next to the
component. Notes and issues are shown in the side panel in green and purple, respectively, to
distinguish them from each other.

1.10.6 Notes/Issues Tab

The Notes/Issues tab is identical to the Notes/Issues tab in the Planning Phase. 
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1.10.7 Productivity Tab

The Productivity tab is identical to the Productivity tab in the Planning Phase. The only difference from
the planning stage is that the Productivity tab now contains Actual G/L section that reflects the actuals
input in the Time Sheet and Quantities tabs, which will be discussed in further detail in the next topic
of this lesson.

1.10.8 Sign In/Sign Out Tab

The Sign In/Sign Out tab is the only new tab for the Execution Phase. It allows crewmembers to sign in
at the beginning of the day, enter breaks, and sign off on the actual hours input into the system at the
end of the day. In addition, at sign-out, it lets a short questionnaire be answered which helps to ensure
all labor rules are being upheld. This section is covered in detail in the final topic of this lesson.
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1 . 11 ACTUALS

In this topic, you will input actual hours, notes, and quantities into a daily plan as part of the Execution
Phase of the daily plan. 

1.11.1 Input Actual Hours

As the workday progresses, you can input the actual hours for the day in the Time Sheet tab of the
daily plan. The process is like that of entering the planned hours in the Planning Phase of the daily plan.
You can also assign an employee to the temporary resource you created earlier during this phase,
although the daily plan can be approved with just the temporary resource if you do not yet have an
employee to assign.

The following Step by Step walks you through how to assign an employee to the newly created
temporary resource.

Assign an Employee Resource to a Temporary Resource

1. From the Daily Plans page, open your daily plan.

2. Click on the Time sheet tab.

3. Click on the chain link icon next to a temporary labor resource.
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4. Type another employee's name into the Search bar.

5. Select an employee.

6. Click Done.

Now that you have assigned a resource to the newly created employee, the next step is to enter the
actual hours for all labor and equipment. 

Temporary Resources can remain on daily plans in the execution phase in order to track and
submit employee hours who may not yet exist in the system. A daily plan can not be approved
in the approval stage until all temporary employees are assigned a system recognized employee

The following Step by Step walks you through how to input actual hours worked into a daily plan. 
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Input Actual Hours Worked into a Daily Plan

1. From the Daily Plans page, open your daily plan.

2. Click on the Time sheet tab.

3. Select the cell next to an employee's name (under the correct task column).
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4. Enter their hours worked in the Actual ST field.

5. Click Done.

6. Review the hours of your other employees and equipment on the time sheet.

7. Enter the hours worked for your temporary employee.

8. Click Done.

1.11.2 Input Actual Quantities

Once you have entered actual hours, the next step to completing the Execution Phase of a daily plan is
to enter the actual quantities installed. You complete this step in the Quantities tab of the daily plan.
The process is like that of entering the planned quantities in the Planning Phase. During the execution
phase you will see the planned quantity column is populated for those components you were expected
to complete.
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The following Step by Step walks you through how to input the actual quantities installed into a daily
plan.

Input Actual Quantities Installed into a Daily Plan 

1. From the Daily Plans page, open your daily plan.

2. Click on the Quantities tab.

3. On the left side, click on a component to highlight it.

4. On the right side, click on the downward pointing arrow next to the component to expand it and
reveal the claiming scheme.
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5. Check the box under the Complete column for each step.

l Notice that by checking the Complete column box, the Installed quantity column will
autofill to the amount in the Quantity column
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You can enter the Installed quantity directly. If the amount entered for the Installed
quantity is the same as the total quantity, the complete box is automatically
checked

1.11.3 Add Notes/Issues

While completing the Execution Phase of a daily plan, it is important to enter notes about factors that
may have affected the execution of the work. This process is identical to the Planning Phase and allows
for the assigning of tags and associations. You can also record issues and they will sync to InEight
Change automatically for tracking.

The following Step by Step walks you through adding a note in the Execution Phase of a daily plan.

Add a Note to the Execution Phase of a Daily Plan

1. From the Daily Plans page, open your daily plan.

2. Click on the Notes/Issues tab.

3. Click on the Add icon and select Add Note.
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4. Enter a helpful note into the free text field at the top of the page.

5. Click on the Add tags button.

6. On the resulting slide out panel, you can select a tag that supports your note/issue.
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7. Click Done to close the slide out panel.

8. Click Done.

1.11.4 Productivity

After adding notes, you can review your tasks, quantities and hours claimed for the task and compare
the actuals to the planned quantity and hours within the Productivity tab. 

The Actual G/L compares the actual cost and man-hours recorded on your executed daily plan to the
budgeted, forecasted or goal costs and man-hours using the following equations:

l Actual Cost G/L = (Sum of (Total actual quantity for the WBS * CE/CB/Forecast/Goal final unit
cost) - (Actual total cost of labor + Actual total cost of equipment))

l Actual total cost of labor = Sum of Total number of hours worked by the employee * Hourly rate
of the employee

l Actual total cost of equipment = Sum of (Total number of equipment hours operated * Hourly
Unit rate of the equipment)
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1 . 12 ATTACHMENTS ON THE WEB

In the web application, you can attach files to a daily plan and view them in both the web and mobile
applications.

1.12.1 Attach a File in a Daily Plan

You can attach files from inside an individual daily plan.

You can also attach files to multiple daily plans from the Management console.

The following Step by Step shows you how to attach a file from your machine to a daily plan.

1.12 Step by Step 1 — Attach a File in a Daily Plan

1. Open a daily plan during any phase of daily planning, and then click the Attach File icon in the
upper left of the page.

2. Click the Add icon in the Attach files to daily plan dialog box.

3. Click SELECT FILES to choose a file from your device or drag and drop a file into the gray box.

4. Click Upload.

To view an attachment, click a file name in the Attach files to daily plan dialog box to download the file
to your device.

You can attach files from InEight Document inside an individual daily plan.
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You can also attach files to multiple daily plans from the Management console.

The following Step by Step shows you how to attach a file from InEight Document to a daily plan.

1.12 Step by Step 2 — Attach a Document File in a Daily Plan

1. Open a daily plan during any phase of daily planning, and then click the Attach File icon in the
upper left of the page.

2. Click the Add icon in the Attach files to daily plan dialog box.

3. Open the Link from InEight Document tab. You can set filter criteria to narrow the list of records
from Document.

4. After you set filter criteria, click Apply. Related Document records are shown in the table.

5. Select the files you want, and then click Link from InEight Document.

To view a Document attachment, click a file name in the Attach files to daily plan dialog box to open
Document in a new window.
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The following Step by Step shows you how to attach a file from an external URL link to a daily plan.

1.12 Step by Step 3 — Attach an External URL Link in a Daily Plan

1. Open a daily plan during any phase of daily planning, and then click the Attach File icon in the
upper left of the page.

2. Click the Add icon in the Attach files to daily plan dialog box.

3. Select the Link External URL tab.

4. Add a Title and the External URL Link and then select Link.

To remove an attachment from a daily plan, select the attachment and then click the Delete icon
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next to the attachment in the right panel.

1.12.2 Attach a File in the Management Console

In the Management console, you can attach files to multiple daily plans at the same time.

For more information about the Management console, see Management Console.

The following Step by Step shows you how to Aattach files from your machine using the Management
console to all selected daily plans.

1.12 Step by Step 4 — Attach a File in the Management Console

1. From the Daily planning home page, select at least one daily plan, and then click Edit multiple.

2. Click Attach and link files in the left panel of the Management console.

3. In the center panel, click SELECT FILES, and then select a file from your device.

You can also drag and drop files into the Management console.

4. Click Add to all daily plans.
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You can also select specific plans in the right panel, and then click Add to selected daily plans.

To remove an attachment from a daily plan, click the Delete icon next to the attachment in the right
panel.

The following Step by Step shows you how to attach files from InEight Document using the
Management console to all selected daily plans.

1.12 Step by Step 5 — Attach a Document File in the Management Console

1. From the Daily planning home page, select at least one daily plan, and then click Edit multiple.

2. Click Attach and link files in the left panel of the Management console.

3. In the center panel, click Link from InEight Document. You can set filter criteria to narrow the list
of records from Document.

4. After you set filter criteria, click Apply. Related Document records are shown in the table.

5. Select one or more records, and then click Attach to all daily plans.

Page 104 of 212 InEight Inc.  |  Release 26.3

1.12 Attachments on the Web Progress User Guide



You can also select specific plans in the right panel, and then click Attach to selected daily
plans.

To remove an attachment from a daily plan, click the Delete icon next to the attachment in the right
panel.
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1 . 13 S IGN IN /S IGN OUT

In this topic, you learn how to sign in, enter breaks, and sign out on a daily plan. 

Title Description

1 Tabs These are still available on the Sign In/Sign Out tab, so you can
review the resources, tasks, and quantities on the daily plan.

2 Subtabs The Sign In/Sign Out tab includes the Sign In, Breaks, and Sign
Out subtabs.

3 Employee
List

Provides a list of all employees assigned to the current plan, with
their trade, craft and employee ID.

4 Hours
Breakdown

Provides a detailed breakdown of the hours worked for both the
current day and week and the shift start and end times. This area
differs slightly between subtabs.

Overview – Sign In/Sign Out Tab
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1.13.1 Sign In Subtab

The Sign In subtab lets you sign in for the day and answer questions at the beginning of your shift.

Depending on settings and permissions, you can also sign in on behalf of all active employees.

Shi f t S tar t T ime

You can enter shift start time. The Shift start field is synced with the Breaks and Sign Out subtabs, so
changes made to the time in one subtab change the others.

If you enter a Shift end value in the other subtabs, you cannot edit the Shift start field in the
Sign In subtab.

Employee Sign- in

To sign in as an employee, select your name. Each employee must enter a PIN (personal information
number) to sign in, which can be your birthdate or a number that the IT personnel has assigned. With
the proper project settings enabled, there is also an option to sign in with a signature.

Sign- in on Behal f o f Employee

Depending on project settings you might also have the option to sign in on behalf of employees by
using signature or PIN.
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Quest ions

When you sign in, you or your crewmember might be asked a set of questions related to the work to
be done that day. These questions are determined by management and set up for the job in the
project settings by an administrator.

l For each question, you can answer Yes or No

l If you give a non-compliant answer, a dialog box lets you put a note as to why you chose that
answer

l You can tap No Exceptions if all answers are in compliance

Employees who provide an answer that is out of compliance must provide a note, and a red
Note indicator is shown with the employee on the sign in tab.

1.13.2 Breaks Subtab

In the Breaks subtab, you can enter up to three breaks per daily plan and per person. To enter a break,
you must enter the start time and length.

1.13.3 Crew Break Hours

If you click the Crew hours icon at the top of the Employee side panel, the Enter crew hours dialog box
opens. In Crew break details, you can enter break start times and lengths for the entire crew.
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If you enter a break time for an individual employee, it overrides the crew break time for that
employee.

At the top of the page, the total number of break hours is shown.

1.13.3 .1 Shi f t S tar t /End Time

You can also change your shift start and shift end times on the Breaks subtab.
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If you change the shift start and end times, the Sign In and Sign Out subtabs change to match
the new times.

1.13.4 Sign Out Subtab

The Sign Out subtab lets you sign out your hours and answer questions at the end of the day. After you
have entered all actuals into the daily plan, the final step before submitting the daily plan for approval
is to sign out all employees on the plan. This is a crucial step because it allows the employees to verify
and approve their hours worked.

Depending on settings and permissions, you can also sign out on behalf of eligible employees.

After an employee signs out, a daily plan can no longer be deleted.

1.13.4 .2 Shi f t S tar t /End Time

You can enter shift hours for an entire crew or for an individual (exception from crew) from the Sign
out subtab.
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To enter hours worked on an individual level, select the crew member from the list, and then select
Edit shift time on the right side to adjust the hours worked for that individual.

1.13.4 .3 Employee Sign-out

To sign out as an employee, select your name, and then review the hours entered by the foreman. You
can then sign the card and either agree or disagree with the hours or negotiate them hours before
signing out. To sign out, you must enter a PIN, which can be your birth date or a number that the IT
personnel has assigned. If a PIN has not been configured, sign out with a signature is required.

1.13.4 .4 Sign-out on Behal f o f Employee

Depending on project settings you might also have the option to sign out on behalf of employees by
using either a signature or PIN.

1.13.4 .5 Cl ient S ign-out

With the proper project settings enabled, you can include client sign-out on the Sign out subtab, either
as an optional or required field, so the client can sign off for the work completed that day.

The Client sign off does not become available until all employees are signed out.

1.13.4 .6 Quest ions

When you sign out, you or your crewmember might be asked a set of questions related to the work
done that day. These questions are determined by management and set up for the job in the project
settings by an administrator.

l For each question, you can answer yes or no

l If you give a non-compliant answer, a dialog box lets you put a note as to why you chose that
answer

l You can select No Exceptions if all answers are in compliance

Employees who provide an answer that is out of compliance must provide a note, and a red
Note indicator is shown with the employee on the sign out tab.
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1.13.5 Time sheet Summary

As a foreman, you can review the Extra pay (allowances) allocated to each employee by selecting the
Time sheet summary icon in the upper-left of the page for all subtabs. This opens a Time sheet
summary dialog box that lists each employee and which of the available allowances they have for their
Time sheet.

From this dialog box, you can view, add, and edit allowance allocations for each employee. As you do
so, these changes update automatically for each employee on the Time sheet and Notes/Issues tabs of
the daily plan.

1.13.6 Crew Hours

To enter the hours worked for an entire crew, select the clock icon at the top of the list of crew
members on the left side of the page for all subtabs.

In the Enter crew hours dialog box, you can adjust the Shift start and Shift end values to reflect the
hours worked by the crew. You can either save these changes after you have finished or cancel the
operation.

The following Step by Step walks you through how to sign out an employee using PIN on a daily plan
and submit the plan for approval. You can also sign out using a signature.
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Sign Out an Employee on a Daily Plan

1. From the Daily Plans home page, open your daily plan.

2. Click on the Sign In/Sign Out tab, and then click the Sign Out subtab.

3. Select an employee from the Employee section on the left.

4. Click on On behalf of employee in the sign-out area.

5. Enter the employee PIN in the sign-out area.

6. Select No for the first question: I was injured while working today.

7. Click Done.

8. In the Employee Override dialog box, enter your initials, and then click Done.
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9. Repeat steps 3-8 for all remaining employees.

10. Click Submit in the upper right.

11. Click Yes.

1 . 14 DA ILY PLAN APPROVAL
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1 . 15 REV IEW ACTUALS

Scenario

You are a field engineer and you are responsible for approving all daily plans that your foreman
executes. Before approving the plans, you need to review them to verify that all the employee
hours and installed quantities are accurate.

In this topic, you will review the actuals of an already executed daily plan submitted for approval,
utilizing the Progress web application.

1.15.1 Why Review Executed Daily Plans?

Reviewing actuals in an executed daily plan is the final step before the plan is approved. This last
review is extremely important; it is the last chance to verify all actual values input during the Execution
Phase are correct, and if there are any mistakes this is the last opportunity to correct them. 

In InEight Progress, once submitted for approval, the daily plan’s status in the Breadcrumbs will
change to Awaiting Approval and the color accents will change from green to purple.
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In the Awaiting Approval Phase, a daily plan has seven tabs (same as the Execution Phase):

l Overview

l Details

l Time Sheet

l Quantities

l Notes/Issues

l Productivity

l Signout

It is best practice when reviewing actuals to examine each tab in detail and verify that all information is
correct. If any information is incorrect or missing, now is the last opportunity to correct it.

The Overview, Details, Time Sheet, Quantities, Notes/Issues and Productivity tabs in the Awaiting
Approval Phase are identical to their respective tabs in the Execution Phase.  All information entered,
edited, or removed in the Execution Phase will be reflected in the Awaiting Approval Phase. 
Furthermore, the Awaiting Approval Phase has the same level of editing as the Execution Phase does
for all the previously mentioned tabs. 

While six of the seven tabs are identical to the Execution Phase, one tab has changed slightly.  On the
Signout tab, instead of the signout area only displaying the employee pin section, now the questions
answered after entering their pin display as well. In addition, there is now an option to reject an
employee’s signout. 
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1 . 16 EMPLOYEE REG ISTER

In this topic, you will review the Employee Register using InEight Progress.

1.16.1 What is the Employee Register?

The Employee Register is a log of every employee assigned to a daily plan. The register provides a
breakdown of which plan each employee is assigned to for a given date, as well as the planned and
actual hours for each of those plans. However, when opened you will only be able to see the
employees for the daily plans that you are assigned to as either an engineer or a superintendent. 

1.16.2 Why use the Employee Register?

In addition to tracking which projects each employee is assigned to and the planned and actual hours
for those plans, the Employee Register also looks for conflicts. For example:

l If an employee is assigned to multiple daily plans for a single day, the register flags that
employee by highlighting it yellow

l If an employee’s total actual or planned hours exceeds the project’s maximum threshold for
hours worked in a single day, the resister will flag that employee by highlighting it red

l If an employee is highlighted in green, then there are no conflicts identified

The following Step by Step walks you through how to access the employee register.

Open the Employee Register

1.

From the Daily Plans home page, open your daily plan.
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The All Projects option in the Projects drop-down list lets you review multiple
projects in Daily Plan Review.

2. Click on the Employee Register icon in the upper right corner of the page.

3. Click on the date near the top of the page. Select the date assigned to your daily plan from the
drop-down calendar.
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Title Description

1 Date Where you can change the date to view employees for different days.

2 View Menu Drop-down where you can change the viewset to view either all
employees or just those with conflicts.

3 Employee
Information

Contains all information for the employee as far as ID, Name and Craft
Description.

4 Employee
Hours

Contains all planned and actual hours (including ST, OT, and DT).

5 Conflicts Notes any conflicts for any given employee.

6 Notes If any notes are associated to an employee, you view them here.

Overview – Employee Register
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1.16.3 Edit Submitted Daily Plan

Scenario

Upon review of the employee register, it appears that your employee, Joseph Kelly, has had his
time entered into two separate daily plans. You now need to go back into your daily plan and
zero out his hours to avoid him receiving double pay. 

In a scenario like the one described above, a simple mistake becomes a prime example of why the
reviewing of the Employee Register is an integral step before approving a daily plan. 

The following Step by Step walks you through how to reject an employee’s signout, modify their actual
hours, and re-sign them out on their behalf.

Adjust the Hours of a Signed Out Employee

1. From the Daily Plans home page, open your daily plan.

2. Click on the Signout tab.

3. Select the employee whose hours you want to adjust, then click on the Reject icon on the right.
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l You should get a pop-up window asking for a reason for rejection

4. Enter a reason for rejection and click Done.

5. Click Yes.

6. Select the Time sheet tab.

7. Click in the entry cell for the worker whose hours you want to adjust.

InEight Inc.  |  Release 26.3 Page 121 of 212

Progress User Guide 1.16 Employee Register



8. Adjust their hours and click Done.
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9. Select the Signout tab.

10. Select the employee whose hours you've adjusted from the employee list on the left.

11. Enter the appropriate pin in the Enter employee pin field.
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12. Answer the signout questions.

13. Click Done.
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1 . 17 APPROVE DA ILY PLANS

In this topic, you will approve a daily plan using the InEight Progress web application.

Once a daily plan has been fully executed, you have reviewed actuals, and the Employee Register, the
plan is now ready for approval. When approving daily plans there are three options:

l Quantity

l Hours

l Quantity and Hours

Each option means exactly what it denotes. If you select quantity, only the quantities for the daily plan
will be approved and the hours will still need to be approved separately. Similarly, if you select hours
only, the hours for the daily plan will be approved and the quantities will still need to be approved
separately. Finally, selecting quantity and hours will approve both at once.

Approve a Daily Plan

1. From the Daily Plans home page, open your daily plan by selecting the plan name.

You can also select the check box and click on theApprove button located in the tool bar.

2. Click on the Approve button in the upper right corner.

3. Select Quantity and hours from the drop-down list.
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l You should get a pop-up window asking if you are sure you want to submit

4. Click Yes.

1.17.1 Bulk Plan approval

When a plan is in the Awaiting Approval status, you can select up to 100 plans at the same time to
approve, or you can select up to 10 plans to reject, and then click the Approve or Reject buttons
located in the daily planning toolbar. The existing approver permissions are applicable for bulk
approval and rejections. Bulk approval is only allowed for reason code-based projects to allow
expediting of data into Time Center.
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CHAPTER 2 — T IME CENTER
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2 . 1 T IME CENTER NAV IGAT ION

2.1.1 Time Center Overview

Time Center serves as a final repository to review and correct Time sheet information before importing
into your payroll system. Time Center allows you to review entries, called time cards, brought in from:

l Daily plans approved within the Progress Daily Planning (Web and Mobile) application

l Progress Weekly Time sheet module

2.1.1 .1 T ime Center Purpose

The purpose of Time Center is to:
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l Review the daily plans (time cards) received from Plan and Progress

l Ensure time cards have the correct properties and data elements

l Edit and correct any potential errors

l Send the reviewed and corrected time cards to your payroll system to process for payment

l Eliminate the need to edit time cards via payroll system database tables or side spreadsheets
exported from Excel

2.1.1 .2 Disp lay Conf igura t ions

The Time center UI is designed for full HD resolution 1920 x 1080 with browser zoom of 100% and
Windows display scaling of 100%. Display configurations other than what is recommended might not
render correctly.

Each InEight application has its own supported display configurations, which might be different than
the configuration above.

2.1.1 .3 T ime Center Access

To access projects in Time center the project setting Use Employee Reason Codesmust be
toggled on. This setting is required prior to creating daily plans and cannot be changed once
daily plans are created.

The Progress time center will show as a sub-level menu option under the account level.

You need to have organization or account access to see the sub-level option for Time center.
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This option requires level 2 or 3 administrator levels. To set the correct administrator level, Go to Suite
administration > Roles and permissions, and then click the Add role icon.

Under Role details, the Administrator level field includes a drop-down menu.

The administrator level can be set and saved only once for every new role.

Title Description

1 Employee /
Equipment
Tabs

Select the appropriate tab to view the time cards for either employees or
equipment.

Overview – Time Center Register Page
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Title Description

2 Date Filter Select the date to filter using a custom date range or from a predefined
calendar.

3 Toolbar Add, edit, delete or copy time cards using the toolbar on the left.
View summary information, make bulk edits, and export time cards using
the toolbar on the right.

4 Query
Shortcut
Icons

The double arrow is a shortcut to expand the Query builder slide out panel.
The blue filter icon indicates how many queries are applied. Yellow filter
icons appear for each filter applied. 

5 Side Panel The upper portion has preset filters to view just time-cards with issues, time
cards in progress, time cards not sent, time cards sent, or all time cards.
The lower portion contains the Query builder to create queries to search for
specific time cards. You can save your queries under My queries, and
access Shared queries.

6 Time card
register

Contains rows and columns that house all time card data imported from
daily plans and weekly Time sheets.

7 View Views can be saved, removed, and shared with users and roles.
Permissions are required for Time Center access.

Overview – Time Center Register Page (continued)
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2.1.2 Time Center Register Columns

The Time Center register contains all the information captured using the Progress application for your
daily plans in the field, as well as weekly Time sheets from the Weekly Time sheets module. The
register columns fixed to the left are pertinent for identifying the time cards and include the Plan ID,
Time card ID, Employee ID, Employee name and Labor/Equipment hours columns. The columns on the
right contain additional data brought in from InEight Progress for you to review for issues.

The following table lists the columns available in the Time center register. You will edit these fields as
needed to make corrections to your time cards. Fields not editable in Time Center can be edited in
either InEight Progress or in your Payroll application, depending on the field.

Column

Editable in
Time
Center? Sortable? Filterable?

Plan Level Fields

Plan ID No Yes Yes

Plan Status No Yes Yes

Daily Plan name No Yes Yes

Date No Yes No

Approver 1 ID Automatic Yes Yes

Approver 1 name Yes Yes Yes

Approver 1 Role Yes-
Conditional

No Yes

Approver 2 ID Automatic Yes Yes

Approver 2 name Yes Yes Yes

Approver 2 Role Yes-
Conditional

No Yes

Labor hour type No Yes Yes

Client approver name No Yes Yes
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Column

Editable in
Time
Center? Sortable? Filterable?

Executor name Yes Yes Yes

Executor ID Automatic Yes Yes

Executor Role Yes No Yes

Shift Yes Yes Yes

Employee Fields

Employee ID Yes-
Conditional

Yes Yes

Employee Name No Yes Yes

Labor Hours Yes Yes Yes

Reason Code Yes Yes Yes

Reason Description Automatic Yes Yes

Trade ID No No Yes

Trade description No No Yes

Employee Fields (Continued)

Craft ID No No Yes

Craft description No No Yes

Override trade Automatic No Yes

Override trade description Automatic No Yes

Override craft Yes No Yes

Override craft description Automatic No Yes

Union code No No Yes

Employee billing class Yes No Yes

Uplift No No Yes

Uplift override Yes Yes Yes
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Column

Editable in
Time
Center? Sortable? Filterable?

Employer company No No Yes

Premium 1-6 Yes Yes Yes

Time sheet Entry Fields

Time card ID No Yes Yes

Task ID Yes Yes Yes

Task description Automatic Yes Yes

Budget Code - Segment 1 (e.g., Cost Center) Automatic Yes Yes

Budget Code - Segment 2 Automatic Yes Yes

Budget Code - Segment 3 Automatic Yes Yes

Budget Code - Segment 4 Automatic Yes Yes

Time card Type No Yes Yes

Labor Cost type Yes No No

Equipment cost type Yes No No

Notes Yes Yes No

Version number No No No

Equipment Fields

Equipment ID Yes Yes Yes

Equipment description Automatic No Yes

Equipment hours Yes Yes Yes

Equipment reason code Yes Yes Yes

Equipment reason code description No Yes Yes

Equipment location No No Yes

Maintenance Fields
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Column

Editable in
Time
Center? Sortable? Filterable?

Work order Yes Yes Yes

Work order description Automatic Yes Yes

Equipment repair number Yes No Yes

Equipment repair description Automatic No Yes

Status Fields

Modified by Automatic Yes Yes

Modified date Automatic Yes Yes

Integration status Automatic Yes Yes

Validation issue? Automatic Yes Yes

Employee shift start Yes Yes Yes

Employee shift end Yes Yes Yes

Plan shift start Yes Yes Yes

Plan shift end Yes Yes Yes

Job title Automatic Yes Yes

The Integration status indicates whether the time cards have been sent to the payroll system.

2.1.2 .4 Sor t Columns

You can sort in ascending or descending (both for alpha and numeric fields) on any column’s header.
Click once to sort the column in ascending order (A-Z, 1-10). A yellow arrow displays on the column
header pointing upward.
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Click a second time on the column header to sort in descending order (Z-A, 10-1), and the arrow will
point downward. Click a third time to reset the column to its default state.

2.1.2 .5 Move Columns

You can move columns using drag and drop to rearrange them as needed and the system will
remember the column order the next time you log in.

2.1.2 .6 F i l te r co lumns

Depending on the project, you may have thousands of time cards to sift through. You can filter your
time cards using column filters to drill down by date, employee, or whatever other criteria you need.

To filter on a column, select the filter icon on the column’s header, then hover over the Filter menu
option.

On the resulting Filter window, you can select an operator and value to filter by.
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The register now filters your time cards by the filter value you selected, and the filter icon on the
column header is yellow to indicate the column is being filtered.

To clear the filter, you would click on the columns filter icon and select Clear.
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2.1.2 .7 Group Columns

With column grouping, you can organize your time cards into groups by the values of a selected
column. By organizing time cards into groups, you can review time cards more efficiently. Grouping
columns lets you group information most applicable to your process, and you can group by any column
without affecting any of the time card data.

To group by a column, click on the column’s header and drag it into the grey area just above the
column headers.

Your time cards are now organized into groups based on the values within the column. Each group is
collapsible and subtotals the labor or equipment hours of the time cards within each group.
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To remove a grouping, click the x on the grouped column header within the grouping area.

The column will return to its placement within the register.

When a Group filter is applied, sorting on any of the data fields will be disabled.

2.1.2 .8 Pro jec t groups

You can view one or more projects at a time in a single grid of data with the project groups option.

Go to Progress Time center, and then click on the drop-down menu labeled Select project group. You
can select previously saved groups, and edit or add a new project group.
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To add a new group, name the new project group, and then select from the available projects or
organizations.

If your resources go across projects, this helps to check employees assigned to multiple projects on a
single page instead of checking each project individually.
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You can still work with a single project. The option to create groups has been added as a quicker work
flow option.

Saved views will migrate while working with groups.

2.1.2 .9 Unique budget code segments

You can populate budget segments to show a unique code label. Unique budget code segments
contain additional options to identify a cost item using four independent fields that are separated by
periods. When you configure unique budget codes at the organization level (All projects &
organizations > Edit organization) the segment numbers are matched with the corresponding columns
in Time Center.
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2.1.3 Unapproved Time Cards

Note that time cards that have not yet been approved and are still in Execution or Awaiting Approval
status are not editable within the Time Center register. You can only edit approved time cards.

2.1.4 Date Filter

You can filter to a specific date for your time cards by either typing the date in the Date field or by
selecting the date from the calendar icon.
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To select a date range, click the add date icon and select an end date.

2.1.5 Time Card Pre-Set Filters

The upper portion of the left side panel contains pre-set filters to help you focus on the time cards that
need review. You have four pre-set filter options you can select from:

l Issues – Time cards that have information on them tagged as issues

l In Progress– Time cards that are in a processing status before sending to Payroll.

l Not sent – Filters to time cards that have an Integration status of Not sent.

l Sent – Filters to time cards that have an Integration status of Sent, or time cards that have been
sent to Payroll
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l All – Shows all time cards within the selected date(s)

2.1.6 Query Builder

In addition to the filters you can set on individual columns, you can also add filters using the Query
Builder. The following steps walk you through creating a query using the Query Builder.

2.1 Step by Step 1 — Create a Query

1. From the Time Center register, do one of the following to open the Query Builder:

l Click on the double arrows next to the left side bar.
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l Click the Add new query link on the left side bar.

2. Type the name of the query in the New query name field.

3. Select Plan ID from the Column drop-down list.

4. Select Equal from the Operator drop-down list.

5. Type a Plan ID value into the Value field.

6. Click Apply.

l The query applies to the timecards on the left

7. Click on the Save query icon to save the query.

l Your query will now show up underMy queries. No one will be able to see this query
unless you share it

l The Share query icon appears. You can share your saved queries with others, so they can
use the queries as well

8. Select the Share query icon.
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l The query will now show up under Shared queries

When you share your query, you cannot edit it until you unshare it.

When you are granted level 2 or 3 permission and the Removed shared queries permission is
enabled, you can unshare a shared query, removing from the shared list for all users.

2.1.6 .10 Fi l te r Ind icators

The number next to the top filter indicator shows how many queries have been applied.

An additional filter indicator displays in yellow for each filter applied. 
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You can hover over the indicator of each applied filter to see the filter name, and you can click on each
indicator to remove them from being applied.

2.1.7 Error Indicators

2.1.7 .11 Errors

Fields that appear in red indicate an error with information on the time card. Time cards with red error
indicators cannot be sent to Payroll. Hovering over the X will give you the reason for the error, so you
can correct information as needed.
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2.1.7 .12 Warn ings

Fields in yellow indicate warnings. Time cards with warnings can still be sent to Payroll, but it is
recommended to fix warnings to avoid possible confusion or issues with time cards. You can hover
over the warning indicator symbol to see the reason for the warning, so you can make corrections. 

2.1.8 Edit notes

You can edit notes originating in the Weekly Time Sheet or Global Time Center.

In the Time card register, under the Notes column, click the Edit note icon. .

The Notes dialog box will open where you can add or edit details.
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In the Photos section, you can click the photo to preview, and a larger version of the photo shows. You
can right-click on the photo to download or delete it.
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2 . 2 T IME CARD MANAGEMENT

2.2.1 Time Card Management Overview

As one who oversees payroll for the project, such as a Project Accountant or Business Manager, you
will use the Time Center page to ensure that the time card entries you received from the Progress
application contain the correct information before passing them on to your accounting system for
processing payroll.

Prior to editing timecards in Time Center, your company will have already established options which
should be available on your time cards, such as for unions, reason codes, allowances, and premiums,
based on your payroll needs.

2.2.2 Time Card Review

Within the Time Center register, you can validate your time card data, reviewing each time card for
issues, and resolving them as needed. Most issues are highlighted in red with an X, such as the
Employee ID fields in the example below.

These Employee IDs may be invalid for reasons such as:

l They may not be assigned to this project

l May have an inactive status during this project

2.2.2 .1 Data Val idat ion Errors

Below is a list of time card errors and their causes. Errors must be resolved before they can be sent to
Payroll.

Error Causes

Invalid Work Order Number Work Order status is not active and is assigned to the
Equipment Repaired Number.
Work Order status is active and is not assigned to the
Equipment Repaired Number.

Invalid Equipment Repaired
Number

Equipment status is not active.
Equipment status is active, but not assigned to current
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Error Causes

project.

Invalid Allowances Employee has an allowance assigned that is not valid for
that type of employee or for the union it belongs to.

Invalid Employees Time card date is not between the employee start and end
dates.
Employee status is not active.
Employee status is set to not report time.
Employee is not currently assigned to the project.
Time card has an operated equipment reason code and the
Employee ID is blank.

Invalid Equipment Equipment status is not active.
Equipment is not assigned to the project.
Employee reason code is "operated", but Equipment ID is
blank.

Invalid Task ID Task is closed for either employees or equipment.
The task is a TEMP (temporary) task.
Cost code is not active.
Cost code is a TEMP (temporary) cost code.
Cost code is not active.

Invalid Labor Cost Type and
Invalid Equipment Cost Type

Cost Type value is not found in the list of available cost
types for the Task ID.

Invalid Reason Code -
Maintenance Record

Reason code is something other than the AWK (Work)
reason code.

Depending on the root cause of the error, you may need to make changes in:

l The Time Center register

l InEight Progress

l InEight Suite Administration

l Your payroll system
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2.2.2 .2 Correct ing Issues Outs ide of T ime Center

The error message displayed below indicates that the “employee is not active for the selected plan
date.”

This means the employee was not contracted during the period of time of the project. The employee
would need to be edited within Suite Administration (accessed from the 1st Level Menu from the
project’s Home page), to be active during the date of the time card. Once corrected, this error would
be removed.

2.2.2 .3 Correct ing Issues in T ime Center

Many of the fields within Time Center are editable. Errors can therefore be corrected directly in Time
Center. For example, perhaps a Reason Code is used on a time card that is associated with an
allowance that is not available. 

You can edit the Reason Code, changing it to one with a valid allowance for the employee on the time
card.

Note that a blue dot appears when any changes have been made prior to saving.
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2.2.2 .4 Other T ime Card Adjustments

You may need to make time card adjustments, even when there is no error. For example, you may
need to override the craft assignment of an employee. You can make this change in the Override Craft
column of the time card.

For craft and trade overrides, the override craft or trade specified for the employee must
pertain to the appropriate union, as assigned at the project level or as defined and imported
from the ERP, otherwise there will be an error.

Page 154 of 212 InEight Inc.  |  Release 26.3

2.2 Time Card Management Progress User Guide



You can also assign or correct premiums. There are identified premiums (created at the project level)
from which you can choose.

Do not confuse premiums with allowances (known as Extra Pay in the Progress application). Unlike
premiums, allowances apply for the entire day.

2.2.3 Saving Changes

As you make changes, be sure to click Save in the upper right-hand corner to save your edits.

Any changes made in Time Center will update automatically in the daily plans of the InEight Progress
application.
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2.2.4 Add Time Card

At times you may need to account for employee hours, allowances, or maintenance hours that were
not captured in a daily plan or weekly Time sheet. Perhaps they were missed, or you need to make a
quick adjustment without going back to the InEight Progress application. You can add a new time card
to record the hours by clicking the Add time card button and selecting the type of time card to add.

Until you save your changes, you will not be able to add or delete any time cards.

A slide out panel opens on the right to fill out and add the time card.
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This same process is followed when you want to create time cards for allowances and maintenance.

2.2.5 Delete Time Card

To delete a time card, you check the row header check box of the time card and select the Delete time
card button.
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2.2.6 Export Time Cards

In Time Center > Export time cards > New data export, you can export time cards with will then send
you to the Export history page. There you can also download previous time card history exports. The
export is a Microsoft Excel file with nearly unlimited time card export count restrictions. If you do not
need to export a specific time card and only need to view the Export history, follow the same steps as
above and select View export history from the drop down list.

2.2.7 Reallocate Time Cards

You can move Weekly time sheet time cards from one project to another project. To move time cards
to another project, you must first create a query that includes all time cards you want to reallocate.
After you create the query, click Time card reallocation in the upper right of the page. In the slide-out
panel, select the query and the start and end dates of all the time cards you want to move. You must
then enter the new project ID. You can also move all time cards to a new task in the new project.
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If you leave the Old task field blank, you can reallocate all selected time cards to one new task.
This is a many-to-one reallocation. If you select a task in the Old task field, only time cards with
that task are reallocated. To do a many-to-many reallocation, you must perform multiple
reallocations.

2.2.8 Submit to Payroll

When all the time cards are reviewed and issues resolved, you can either select the time cards
individually, hold the shift key to multi select or check the box to select all time cards.

With the time cards selected, click the Send Selected button.
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This sends the selected time cards to your Payroll system.

2.2.9 Approval Delegation Permission

The Approve team time sheets for others option allows the selected employee to submit time sheets
(other than a supervisor). Go to Roles and permissions > Weekly time sheet, and then select Approve
team time sheets for others.

2.2.9 .5 In tegrat ion Val idat ion

The system will validate the information to make sure there are no errors.

l If there are errors, that time card will not be sent

l If there are no errors, the records are put in queue and sent to your ERP system to be processed
for payroll

Once processed, you will get back a result from Payroll indicating whether it succeeded or failed. If
successful, the Integration status updates to Sent – current.
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CHAPTER 3 — WEEKLY T IME
SHEET
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3 . 1 WEEKLY T IME SHEET OVERV IEW

Weekly Time Sheet is an organization-level module that lets you manage individual or team work hours
on a weekly basis.

Weekly Time Sheet is a convenient option for workers who are utilized across projects, or for indirect
personnel who need to enter time without being associated to a specific daily plan. Work hours,
allowances, and equipment hours can be recorded through Weekly Time Sheet.

Depending on your project settings, you will likely use one of the following workflows in Weekly Time
Sheet:

Teammembers create their own time sheets and submit
them for payroll processing on a weekly basis.

Team members create their own time sheets. Team leaders
review team time sheets and submit them for payroll
processing.

Team leaders create time sheets for their team and submit
them for payroll processing.
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3 . 2 WEEKLY T IME SHEET SETUP

To enable Weekly Time Sheet for your organization, the following areas must be configured with the
appropriate details:

l Organization Setup

l Employee and User Setup

l Project Setup

To set up Weekly Time Sheet, it’s recommended that you complete the following steps in order.

3.2.1 Organization Setup

3.2.1 .1 Budget Code Setup

The Unique Budget Code setting is required in order to use Weekly Time Sheet. Follow the steps below
to enable unique budget codes.
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Enable Unique Budget Codes

1. Open the Main menu and select All Projects & Organizations.

2. Open the Organizations tab.

3. Select the root organization and click the Edit icon.
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4. Under the Budget Code section, click the toggle to enable unique budget codes.

5. Click Save.

3.2.1 .2 Organizat ion Set t ings

Confirm that your fiscal period settings are appropriate for Weekly Time Sheet.
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Confirm Fiscal Period Settings

1. From the Organization menu, select Fiscal calendar.

2. Set theWeek ending day to Saturday or Sunday.

l Setting this field to a weekday might impact performance.

3. Click Save.

Confirm that organization reason codes are set up correctly.
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Confirm Reason Code Settings
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1. From the Organization menu, select Settings.
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2. Open Progress settings.

3. Under the Time configuration section, click the toggle to enable default reason code time entry.

4. Confirm that IDs are set up in each of the following tables:

l Employee reason codes

l Equipment reason codes
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5. Click Save.

Confirm that employee premiums and allowances are set up correctly.

Confirm Premiums and Allowances

1. From the Main menu, selectMaster data libraries.

2. Select Payroll indicators.

InEight Inc.  |  Release 26.3 Page 173 of 212

Progress User Guide 3.2 Weekly Time Sheet Setup



Page 174 of 212 InEight Inc.  |  Release 26.3

3.2 Weekly Time Sheet Setup Progress User Guide



3. Open the Allowances tab. Confirm that appropriate allowances are set up.

4. Open the Employee Premiums tab. Confirm that appropriate premiums are set up.

3.2.2 Employee and User Setup

3.2.2 .3 Roles

In Weekly Time Sheet, time cards can be entered by a supervisor, a team leader, or directly by
employees. Depending on the needs of your organization, you may modify user roles to include
permissions for Weekly Time Sheet or create custom roles to ensure appropriate access.

The following permissions are available for Weekly Time Sheet:

Title Description

1 View my weekly time
sheet

Allows the user to access the Weekly Time Sheet module and
view their personal time sheet.

2 Add my weekly time
sheet

User can add a new time sheet.

3 Edit my weekly time
sheet

User can edit a saved time sheet.

4 Delete my weekly time
sheet

User can delete a saved time sheet.

5 View team time sheets User can view time sheets for other employees assigned to
their team in Weekly Time Sheet.

6 Add team time sheets User can add a new time sheet for a team member.

7 Edit team time sheets User can edit a team member’s saved time sheet.

8 Delete team time
sheets

User can delete a team member’s saved time sheet.

9 Approve team time
sheets for others

User can approve time sheets for other employees assigned to
their team in Weekly Time Sheet.

Weekly Time Sheet Permissions

Modify Roles
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Follow these steps to confirm that a role has appropriate permissions for Weekly Time Sheet.

Review Roles

1. From the Main menu, select Suite administration.

2. Select Roles and permissions.

3. Select a role and click the Details icon.
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4. Under Permissions > Progress, review the current permissions for Weekly Time Sheet.

5. If the role does not include the appropriate permissions, click the Edit icon.

6. Under Progress > Weekly time sheet, select the checkboxes to assign permissions.
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7. Click Save.

You can assign an additional role to the user instead of changing permissions for their current
role, if necessary.

Create a Custom Role

For users who do not require other permissions in the Suite, custom roles can be created to grant
access to Weekly Time Sheet. For example, a role can be created for team leaders who need to
approve team time sheets, but who do not have any other supervisory permissions for your
organization. Similarly, a custom role can be created for employees who need to access Weekly Time
Sheet to manage their personal time cards, but who do not require access to other areas of the InEight
Suite.

Visit Roles and Permissions to learn how to create a custom role.

The following table details the permissions required for accessing Weekly Time Sheet, managing
personal time sheets, and managing team time sheets. You can access these permissions under Suite
administration > Roles and permissions.
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Weekly Time Sheet
Function Section Group Permissions

Access Weekly Time
Sheet (Administrator
Level 0 - Base)

Master
data
libraries

Operational
employees

View employees

Progress Weekly time
sheet

View my weekly time sheet

Manage personal time
sheets (Administrator
Level 1 - Project Admin)

Progress Weekly time
sheet

Add my weekly time sheet
Edit my weekly time sheet
Delete my weekly time sheet

Manage team time
sheets (Administrator
Level 1 - Project Admin)

Progress Weekly time
sheet

View team time sheets
Add team time sheets
Edit team time sheets
Delete team time sheets
Approve team time sheets for
others

Accessing Weekly Time Sheet

The minimum permissions for Weekly Time Sheet users are "View employees" and "View my
weekly time sheet."

3.2.2 .4 Users

With roles set up in Suite administration, you can grant users appropriate access to Weekly Time
Sheet.

Add a User Role

1. Open Suite administration > User management.

2. If the individual does not already have a user record, click Add users and enter user details. If the
individual already has a user record, select the user and click the Edit icon.

3. Switch to the Roles tab and click Add role.
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4. Open the Role drop-down list and select an appropriate role.

5. Open the Organization/Project drop-down list and select the organization.

l Weekly Time Sheet is an organization-level module. Make sure the role is assigned at the
organization level.

6. Click Save.

3.2.2 .5 Employees

Confirm that team members have an active employee record and are available for selection in Weekly
Time Sheet.
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Review Employee Record

1. OpenMaster data libraries > Operational resources.

2. On the Employees tab, select the employee’s trade and craft.

3. Select the employee and click the Edit icon.

4. Under the Employee details section, confirm that the employee has a current Start date and End
date.

5. Under the Time reporting section, click the toggle to enable Employee available for selection in
weekly timesheet.
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6. Click Save.

3.2.3 Project Setup

3.2.3 .6 Pro jec t Deta i ls

Confirm the project details.
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Confirm Project Details

1. From the Project menu, select Project details.

2. Under the Project details section, set the Status to Active.

3. Under the Project dates section, select a Project start date and Project end date.
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4. Click Save.

3.2.3 .7 Ass ign Employees

In addition to setting up users and employees at the organization level, employees must also be
assigned to one or more projects in order to be available for selection in Weekly Time Sheet.

Before assigning employees to a project, confirm that you have completed the following steps:

l The employee has an active record created in Master Data Libraries, and the setting Employee
available for selection in weekly timesheet has been enabled.

l If the employee needs to manage their own time cards in Weekly Time Sheet, confirm that they
have a user record created in Suite Administration with the appropriate role(s).

Assign Employees to Project

1. From the Project menu, select Assigned operational resources.
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2. Click the Add icon.

3. Click the Add icon to add employees to the list of selected employees.

4. Click Add.
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3 . 3 WEEKLY T IME SHEET NAV IGAT ION

3.3.1 Open Weekly Time Sheet

To open Weekly Time Sheet, select your organization from the Main Menu. Under Progress, select
Weekly time sheet.
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3.3.2 Weekly Time Sheet Register

The Weekly Time Sheet register is the main page of Weekly Time Sheet. From the register, you can
manage team members, review and modify time cards, and submit hours.

Title Description

1 Side panel Access your personal time sheet or team member time sheets. Manage
team members.

2 Date filter Select a week range to view time cards. Copy time cards from the
previous week.

3 Toolbar Save or cancel changes. Submit hours for all team members.

4 Time sheet
summary

View name and ID for current employee. See total hours, double time,
overtime, and standard time for the selected week.

5 Employee
grid

Add, edit, or delete time cards for the current week. Access links to
associated daily plans. View notes associated with employee time cards.

6 Allowances
grid

Add, edit, or delete assigned allowances. Access links to associated
daily plans.

7 Equipment
grid

Add, edit, or delete hours for equipment operation.

Weekly Time Sheet Register
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3 . 4 MANAGE TEAM MEMBERS

If you are a supervisor or team leader, you can track, review, and submit hours for your team through
Weekly Time Sheet.

As the supervisor or team leader, you must be added to a project as an assigned operational
resource in order to manage team members on that project.

3.4.1 Manage Team Members

The following steps walk you through how to add, reorder, and remove team members in Weekly Time
Sheet.
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Manage Team Members

1. From the left panel, selectManage team members.

2. Under Available team members from project, select the checkbox for the team member(s) you
want to add.
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3. Click the right arrow to add the employees to the list of selected team members.

4. To change the order of the employee list, drag and drop the employee row to a new position.

5. To remove an employee from Weekly Time Sheet, select the employee from the list of selected
team members and click the left arrow.
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6. When you’re finished, click Save.

7. You now see the updated list of team members in the left panel.
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After you add employees to your list of team members, you can manage their time sheet by selecting
the employee name from the left panel.
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3.4.2 Troubleshooting

If the team member you want to add does not appear in the list of available team members, check the
following details:

l An employee record must be created inMaster Data Libraries > Operational resources.

l The employee record must include valid Start and End dates which do not conflict with the
project dates.

l The employee record must have the setting Employee available for selection in weekly
timesheet enabled.

l The employee must be assigned to a project under Project Settings > Assigned operational
resources.

l You, or the user who is managing team members, must be assigned to the project under Project
Settings > Assigned operational resources.
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3 . 5 MANAGE T IME CARDS

A time card is a specific time entry associated with a single project and reason code. A time sheet
comprises the weekly time card entries for one employee.

To manage time cards in Weekly Time Sheet, users must have appropriate roles and permissions
set up and be assigned to one or more projects as an operational resource.

3.5.1 Create Time Cards

The following steps walk you through how to create a time card and input hours.

Create a Time Card

1. If you are managing time cards for a team member, select the team member from the left panel.

2. Select the week from the date filter in the top toolbar.
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3. In the Employee grid, click the Add icon.

4. Select the project and reason code from the drop-down menus. Then click the Add icon.
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A new row for the time card now shows in the Employee grid.

5. Open the Task ID drop-down and select the work task.

6. Scroll to the right. Enter the work hours in the date fields.
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l Blue dots indicate unsaved changes.

7. If there are work hours for a different project or associated with a different task, click the Add
icon to add a new time card row.

8. When finished, click Save in the top toolbar.

3.5.1 .1 Add & Review Notes

Notes can be associated to specific time cards in the Employee grid. Time cards with notes are marked
with a blue corner indicator. To view the notes on a time card, right-click the indicator, and then select
Manage notes.

The Notes slide-out panel opens. In the slide-out panel you can add new notes, view, or edit existing
notes.
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Follow these steps to add a new note to a time card.

Add A NEW NOTE

1. From the employee grid, click the Notes icon.

The Weekly Time Sheet register is disabled while you manage notes.

2. From the time card row, click a calendar day.
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3. Click Add notes from the top of the Notes slide-out panel.

4. Type your note in the text field, and then click Save.
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5. Your note now shows in the Notes slide-out panel.

6. Click Close to close the slide-out panel.

7. When you are finished managing notes for this time sheet, click the Notes icon again.

Notes added in Weekly Time Sheet are also visible in Time Center after the time sheets are submitted.
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3.5.1 .2 Add Al lowances

Follow these steps to add allowances to a time card.

Add Allowances

1. In the Allowances grid, click the Add icon.

2. Select the project and allowance ID from the drop-down menus. Then click the Add icon.
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3. Select the checkbox for each date the allowance is applied to.

4. When finished, click Save in the top toolbar.

3.5.1 .3 Add Equipment Hours

Follow these steps to add equipment hours to a time card.
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Add Equipment Hours

1. In the Equipment grid, click the Add icon.

2. Select the project from the drop-down menu, then click the Add icon.

3. Open the Equipment ID drop-down and select the equipment.
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4. Open the Task ID drop-down and select the work task.

5. Enter the hours that the equipment was operated in the date fields.

6. When finished, click Save in the top toolbar.

3.5.2 Copy Time Cards

If there are no entries for the current week, you can save time by copying time cards from the previous
week.

Select Copy timecards from previous week from the top toolbar.
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You can delete or modify entries after they have been copied from the previous week.

3.5.3 Review Time Cards

Employee hours submitted through a daily plan appear in green in Weekly Time Sheet.

Daily plans in the execution, awaiting approval, and approval phase appear in Weekly Time Sheet.

If you are the executor on a daily plan, you can make changes to the reason code or Task ID of a time
card. However, hours submitted through a daily plan cannot be modified in Weekly Time Sheet.

3.5.4 Submit Hours

After all hours are input for the week, you can submit them to Time Center for final review before they
go to your payroll system.
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To submit hours to Time Center, click Submit all hours.
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3.5.4 .4 Superv isor Approva l

Your organization may require a team leader or supervisor to approve employee time cards before
they are submitted for payroll processing. To set up supervisor approval, ensure that the following
steps have been completed:

l In Organization Settings > Progress > Weekly Time Sheet: Enable the setting "Supervisor approval
required"

l In Master data libraries > Operational resources > Employee record
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l Assign a supervisor

l Enable the setting "Requires supervisor approval".

Follow these steps to edit an operational resource.
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Edit Operational Resource

1. OpenMaster data libraries > Operational resources.

2. Select a resource and click Edit resource.
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3. Under Employee details, enter a name or employee ID in the Supervisor field.

4. Under Time reporting, click the setting "Requires supervisor approval" to enable.
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With supervisor approval enabled, employees can enter their hours in Weekly Time Sheet and click
Submit all hours. The time sheet is now in the approval step, and their supervisor receives a
notification.

Supervisors can reject, edit, or approve submitted time sheets.

In Time Center, time cards set up for supervisor approval will show a status of Awaiting Submission,
Awaiting Approval, or Approved.

3.5.4 .5 Automat ic T ime Sheet Approva l

Time sheets are automatically approved in the following cases:

l If the setting “Supervisor approval required” is not enabled in Organization Settings

l If an operational resource does not have an assigned supervisor

l If a supervisor enters and/or submits an employee time sheet

l If a supervisor submits their own time sheet
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